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What Is FirstClass?
FirstClass is an advanced conferencing, electronic mail, bulletin board, and online communication system 
with a graphical user interface. With FirstClass, transferring files and sending messages is easy and quick 
because all modem and file transfer protocols are handled automatically.

With FirstClass you can...

Send and receive mail from other users, even on other 
systems such as CompuServe and the Internet.

Transfer any number of files quickly using the 
FirstClass attachment feature.

Engage in electronic conferencing with other users on 
a variety of topics.

Dial in using a modem while retaining the full graphical 
interface of your computer's operating system.

Engage in a real-time chat with other users online.

FirstClass was designed for computers with a graphical user interface. This means that information is 
presented in an intelligent, organized fashion. You can find what you are interested in quickly, without 
sifting through reams of unwanted information. You can point and click to read a particular message or 
conference item without having to sort manually through all the messages on a particular topic.

Nothing in FirstClass forces you to wait; you can read a message in one window, browse a conference in 
another, compose a memo in a third, and chat with another user in yet another window, all while 
transferring a file in the background. FirstClass provides the ideal environment for online electronic 
communications.

Related Topics:
Electronic Mail
Conferencing
Remote Access
Multi-Platform & Language Support
Bulletin Board Features



Electronic Mail
As an e-mail package, FirstClass is exceedingly powerful.

With features like online sound and graphic viewing, various graphical "office memo-like" message forms, 
simple name-based addressing and file attachments, FirstClass matches other popular e-mail programs 
function for function.

Add innovative features like drag-and-drop mail filing into custom folders, automatic copies of sent mail, 
auto expiry of old mail and the best message tracking features in the business (showing who read your 
mail, when, whether they forwarded or replied to it or whether they downloaded any attached files)... and 
you've got a system very unlike the others.

Lastly, important connectivity via FirstClass gateways to other FirstClass servers or foreign mail systems 
is addressed through a series of gateways by SoftArc and various third-parties.



Conferencing
Electronic group discussion is being considered more and more important to large workgroups.    Most e-
mail systems don't provide for elegant group communication, and stand-alone conferencing packages are 
poorly laid out and tend not to address private e-mail at all.    FirstClass is the fullest-featured, most robust 
system for organizations needing to share vital information among their staffs and customers because it 
addresses both needs with the same interface.

Features of FirstClass important to electronic discussion include accurate "unread" tracking per-item per-
user, message tracking, multiple hierarchical conferences and the ability to place aliases of frequently-
followed conferences on one's desktop.    Add per-user customizable conference layout, user to user 
realtime chatting across platforms and an incredibly powerful system of permissions and privileges 
controlling who gets access to what.

With the Internet gateways available for FirstClass, it's even possible to replicate Usenet newsgroups 
within FirstClass conferences... allowing users to read and reply to network news from their normal 
FirstClass mail system.



Remote Access
Network managers worldwide agree remote access to their network has become one of their the biggest 
priorities¾and biggest headaches.

Remote access has traditionally meant complicated routers, terminal servers, network modems and 
remote access servers... which for some networks has meant dedicating a separate computer for every 
incoming phone line.

However, while access to network services is important, statistics show more than 80% of those 
connecting via modem to their network are doing so to access their e-mail exclusively

FirstClass solves problems for network administrators by natively supporting up to 22 conventional 
modems, high speed or otherwise, on one FirstClass mail server.    The FirstClass server handles modem 
connections and efficiently.    FirstClass pleases network managers even more by allowing the 
administation of FirstClass systems remotely¾making server to server gateway setups or other 
occasional maintenance a snap.

FirstClass solves remote access problems for users, who may access their FirstClass system remotely 
the same way they do in their office, using the same client application they're used to.    No special remote 
access software to worry about.    Every system feature looks and works the same.

Modem access is highly efficient and permits background transfer of files (in both directions 
simultaneously) even while reading mail, chatting or using other system features in the foreground.    Truly 
a revolution in remote communication.



Multi-Platform & Language Support
Not everyone uses the same computer type or speaks the same language.    Administrators with such 
mixed networks suffer headaches above and beyond those created by remote access.    E-mail programs 
have always been the most difficult cross-platform applications to configure and set up.    And there hasn't 
ever been a usable, cross-platform network conferencing package before FirstClass.

FirstClass allows users of different computer types to share the same physical network without the need 
for a dedicated network fileserver.    The FirstClass server understands different packet protocols at the 
server level courtesy of software routing; Windows machines can speak to a Macintosh-based FirstClass 
server over IPX, and Macintosh users can be connected simultaneously.    This allows network users of 
different machine types to even chat in real time with each other through FirstClass.

The FirstClass client and its message forms are virtually identical across different platforms.    FirstClass 
users of one computer type feel completely at home using a FirstClass client on another machine.

The FirstClass client is available not just for different platforms, but for different languages as well.    
Versions of the client are available in French Canadian, German, Portugese, Spanish, Japanese, 
Swedish and others.



Bulletin Board Features
More groups are finding the need to communicate with others in the world beyond their walls and are 
turning to computers to do so.    Some choose to set up an internal bulletin board, or BBS, for customers 
to download pricing or product information, report problems, seek technical help or generally 
communicate with others in the organization.    But this type of communication is not practical unless 
closely married to one's internal e-mail system.

Because FirstClass accommodates modem connections as well as it does, supports as many 
simultaneous modem connections as it does and offers such an easy to use interface, it has become the 
software of choice for those needing bulletin-board features linked to an industrial-strength corporate 
messaging system.

The same single FirstClass server that accommodates thousands of regular network users may also 
accommodate thousands of modem user accounts.    Up to 250 users, regular and telecom, may be 
simultanously accommodated on one FirstClass server.

When considering FirstClass on its BBS related features, the ability to access and search CD-ROMS or 
other volumes online is very useful, as is the ability to send mail to any user or conference the BBS user 
has permission to.    Accurately track what users have uploaded or downloaded what through statistics 
and billing features.    Create custom icons and background pictures.    Accommodate users of any 
computer type through a command-line interface to FirstClass similar to the UNIX shell if they call with a 
VT-100 compatible terminal.

Of course one of the primary reasons to use FirstClass for a BBS lies in the strength of its multitasking 
graphical interface¾an interface that yeilds impressive performance and functionality on a network... and 
is equally impressive by modem.



Who Uses FirstClass?
As of early 1993, SoftArc has sold systems which total over 250,000 FirstClass mailboxes and over 
30,000 conferences in dozens of countries around the world.

The following are some of the places FirstClass is being used, and why.

Business

FirstClass is used by many businesses as an integrated remote access customer support system and 
local office e-mail system.    Clients may call in and leave mail, which provides immediate notification to 
the recipient, who can then access the server over the network to read the mail.    Conferences on product 
information, areas for questions and answers and background technical information significantly reduce 
the load on support personnel.    SoftArc's own system is used this way.

Other companies find the network conferencing features of FirstClass combined with remote access 
provide an excellent set of groupware tools for their various departments.    With electronic conferencing, 
people can develop ideas without actually meeting face to face.    And by calling in by modem from home, 
they can often work on a project away from the bustle of the office.    Since FirstClass supports ANSI 
terminal emulation as well as Macs, users can connect remotely from any computer¾including the 
miniature pocket organizers that are becoming increasingly popular.

Businesses which process electronic information find FirstClass an excellent way to exchange files with 
clients and transport them within the organization.    A large number of Service Bureaus use FirstClass to 
allow customers to send in electronic print jobs without the need for a courier.    The integrated FirstClass 
mail system can notify managers immediately when a job has arrived without needing to be logged in to 
the server at all times.    Since FirstClass supports background file transfers, clients can fill in annotated 
comments and job specifications while files are being uploaded.

Service Bureaus are choose FirstClass because of the interface's simplicity of use.    And because the 
FirstClass client software is freely distributable, many pre-configure diskettes for their clients, who only 
have to click on the "login" button once they've inserted the diskette into their machines.    FirstClass takes 
the mystery out of telecommunications for novices.

E-mail, conferencing and remote access in a single package puts the necessary tools for group 
interworking at the fingertips of everyone in an organization¾regardless of where they connect from.

Businesses using FirstClass that have authorized us to give out their names include:

Aldus, Cisco Systems, K-Mart, Eastman Kodak, Agfa, Adobe Systems, General Electric, MicroBoutique, 
Oracle Corporation, Space Telescope Science, TransAlta Utilities, Schlumberger, Trident Data Systems-
Lockheed Missiles & Space, The Bartering Company Ltd., Linotype-Hell, Pacific Gas & Electric, Booz 
Allen & Hamilton, Betz Paperchem, Motorola, Manhattan Graphics, Harley-Davidson, Motown Records

Education

FirstClass is used by school boards around the world.    Many use it to link teachers together from school 
to school with e-mail and private conferencing, but many more use it to facilitate communication among 
students locally and globally.    FirstClass ties in perfectly with global e-mail services like the UNIX 
Internet, allowing teachers to communicate with colleagues around the world, and students to develop 
pen-pals in remote areas.

Some educational sites use FirstClass for curriculum discussions among teachers and distribution of 
learning materials.    Because FirstClass servers can gateway together by network or modem to exchange 
both private mail and conference items, it's an ideal system for school boards spanning large geographic 
areas.

A large number of universities use FirstClass for conferencing among students and faculty access to a 
variety of local university network resources.

Extensive security features built into FirstClass can permit students to access only limited portions of a 



given FirstClass system without having to worry about sensitive information posted elsewhere within the 
same server.

Large educational installations using FirstClass that've authorized us to give out their names include:

University of Maine, University of Texas, University of Lancaster, Emory University, University of Arizona, 
Syracuse University, University of California, University of Portland, San Francisco State University

Public Services & Government

FirstClass is used by government and public services.    The U.S. Fire Department uses FirstClass as an 
e-mail and information service.    Staff access their system by network or remotely from Macs installed in 
some fire trucks.

FirstClass can also be used to organize and store documents, and to air ideas and proposals to large 
groups of people without the need to meet constantly.    Since many government departments contain a 
hybrid of Macintosh and PC machines, the interworking and support for both Macs and PCs provided by 
FirstClass either over the network or via remote access is especially important.

FirstClass can also be used to provide information services to the general public and the mass media via 
telecom connections or the FirstClass fax gateway, which provides for broadcast fax transmission.    This 
is an excellent way to disseminate information on government programs, policies and assistance while 
keeping the cost of running such a service low.

User Groups

FirstClass is lauded by computer user groups because its graphical interface preserves the look and feel 
of the popular Macintosh and Windows graphical interfaces even when accessed over telephone lines.    
Many use it to run online services for their members, because the software provides an excellent means 
for disseminating information, providing access to large file selections (including CD-ROMs), and 
facilitating on-line chatting between members.    Users who don't yet have a copy of the FirstClass 
graphical interface, or who find that one isn't available, may access their group's FirstClass server through 
the optional command line user interface to FirstClass.    All the user needs is a conventional VT-100 type 
terminal program at their end.

In Canada, the MAGIC user group operates a large, busy system in Toronto.    It provides its members 
with several gigabytes of files and many special interest conferences, plus it carries many Usenet news 
conferences.    Anyone in the world may access this FirstClass system for free with the FirstClass client or 
another terminal program by dialing 416-288-1767.

In the U.S., one of the more popular public FirstClass systems is OneNet Los Altos in the heart of Silicon 
Valley.    This fine system boasts large file areas, a knowledgeable user base and is where the global 
"OneNet" affiliation of public FirstClass BBSes began.    Now more that 130 public systems around the 
world carry OneNet conferences.    The main OneNet system may be accessed at 415-948-1349.

BMUG, the world's largest Macintosh User Group, also operate a large FirstClass system in Berkeley, 
California.

Public BBSes

FirstClass is one of the most popular programs among individuals who set up public information services, 
or bulletin boards, as a hobby.

Hundreds of FirstClass systems are used in this way all over the world.    Many of them belong to the 
OneNet network of FirstClass systems, discussed in-depth later, and are run on computers people's 
basements.    Enthusiasts often purchase the software and hardware they require and rent several phone 
lines out of their own pockets, without charging the users of their systems.

Those using FirstClass as a BBS usually disregard its built-in network access features and take 
advantage of economical multi-modem support from one server and low maintenance requirements.    The 
conferencing aspects of FirstClass, gateways to other systems and services, remote administration and 
powerful security features are used every day by the BBS administrator.    Finally, admins¾who often can't 
babysit their systems 24 hours a day¾appreciate the robust FirstClass server architecture.



Around The World

As of this posting, FirstClass is running in over 25 countries around the world including such exotic 
locations as Bermuda, Chile, Australia, Japan, Turkey and Malaysia.



How Does FirstClass Work?
FirstClass™ is a deceivingly sophisticated product.    Deceiving because it puts an immense amount of 
communication power into anyone's hands underneath its easy to use intuitive graphic interface.    And 
sophisticated because of its flexibility and open-endedness of interface design, intimacy of client/server 
relationship and underlying software architecture that truly makes it a superior communications tool.

FirstClass imparts to companies and individual enthusiasts the power to run information servers of a 
sophistication that required mainframes and fulltime white-coated lab technicians only a few years ago.    
And at a fraction of the price and requiring considerably less technical expertise!

There are important technical factors that make FirstClass a logical choice for your communication needs:

FCP

FirstClass Protocol, or FCP, is SoftArc's proprietary protocol used for packet transmission between the 
FirstClass server and client.    Rather than base the product on existing network protocols, SoftArc saw 
the need for a reliable error-checking, sliding window protocol optimized for both network and modem 
connections... from day one.    Because SoftArc development staff had a background writing low-level 
network protocol code (see "About SoftArc, further in these files) the decision was made to spend five 
months of development effort on this protocol before work on the FirstClass server or client were even 
considered.

The result: perhaps one of the industry's most optimized, reliable, ISO-compliant (true seven-level layered 
design, i.e. "presentation layer", "physical layer" etc.) communication schemes ever.

FCP is the method by which the FirstClass server and client communicate, and is of such high-
performance that one Macintosh-based FirstClass server may accommodate up to 250 simultaneous 
users.    It is also the prime reason FirstClass is usable over modem natively as well as it is.    Because 
FCP is fully bidirectional, simultaneous uploading and downloading in FirstClass over network and 
modem is possible and completely reliable... because it is a basic operation at protocol level.

The standardized, layered nature of FCP also allows for relatively straightforward and quick ports of client 
and server to other hardware platforms and physical protocol layers such as IPX.

True Client-Server Architecture

Rather than simply presenting the guise of a client-server system, FirstClass sets the standard for other 
client-server applications.

Again, because of the SoftArc development team's background writing client-server applications for 
Northern Telecom, they've been uniquely qualified to write into FirstClass their best work yet.

The FirstClass server application only boasts one status screen as its display, but it's one of the most 
durable, hardy servers in the industry.    The approach taken by SoftArc is that a server should be merely 
a black box somewhere on one's network, routing bytes and communicating via a high-performance 
protocol with whatever client should connect to it, all through a reliable multitasking kernel.    A server 
should treat all clients with the same priority.    All of these were factors that went into the design of the 
FirstClass server.

Other factors that influenced server design involved notions of acceptable downtimes that the authors of 
FirstClass learned from working on phone switch equipment at Northern Telecom.    While SoftArc admits 
it falls a bit short of the one hour of acceptable downtime in 20 years rule that phone switch development 
demands, the FirstClass server is many times more stable than other so-called industrial quality mail 
servers.

Also figuring prominently into the success of the FirstClass server is the decision to support multiple 
network protocols at the server level.    SoftArc's opinion is that a true server should understand whatever 
network protocol the client needs to speak, similar to Novell's approach... and not the other way around.    
This is why FirstClass supports the various protocols it does natively, and why several others are just 



around the corner.

Because the FirstClass server is innocuous and easily administered on a network machine or remotely 
through the client application, many people runnning servers in institutions lock their machines in closets.

The FirstClass client is the part of FirstClass that both users of the system and administrators themselves 
use.    It is the same software one uses to connect to a FirstClass server over the network or modem.    It 
is freely distributable, so a company or other group purchasing a FirstClass system may make as many 
copies of the client as they like and distribute them to employees... or their even customers who'd like to 
log into their mail system via modem.

The client translates the packets the server sends via FCP into the information these bytes represent on 
the users' screen.    The client contains all of the graphics, icons and graphical elements that make up 
forms, so that the server only has to send the actual bytes of message summary data in a message 
summary window when a conference is first opened, for example.    A further testament to the pre-emptive 
multitasking nature of FCP is the ability to open any message as soon as you read its summary as they 
arrive in a given listing.    Other mail systems make you wait¾even when on the network¾for your mailbox 
to fill up before you may open anything in it... which could take 30 seconds if you've a lot of mail!

While it may not seem like it, the Command Line User Interface option for FirstClass is an FCP client as 
well.    The CLUI is an option that installs on a FirstClass server to enable logins via modem with VT-100 
compatible terminals.    It communicates with the server via FCP and translates into a format readable by 
the VT-100 user.

The graphical FirstClass client is available free of charge in a variety of languages and computer 
platforms.    Users or administrators may download versions in German, Portugese, French, Japanese 
etc. from SoftArc Online, SoftArc's support system.    Currently versions are available for Macintosh and 
Windows machines.



FirstClass Up Close
Standard Graphical User Interface

The FirstClass graphical interface adheres closely to the Macintosh and Windows interface 
standards¾users can double click to open items, may drag items, etc.    The system is intuitive and easy 
to learn by anyone who's ever used a Macintosh or Windows machine.

Online Help

-A complete online help system is available to all users.

-May be customized by the administrator to add help specific to their application or system.

Multi-Window Multitasking

-Users may open multiple windows to view multiple items or conduct several operations simultaneously.

-Allows easy cutting and pasting of text from message to message

-All file transfers between the user and the server take place in the background.    Users can continue to 
read and compose mail or chat with others, even when a multiple file upload or download is in progress.

-Users can always start new actions whenever they like and rarely see the dreaded watch or hourglass 
cursors.

-No practical limit on number of consecutive operations.

Viewing Modes

-FirstClass can display folders and their contents either by icon or by a list view.    Forward or reverse 
sorting quickly changes the order of displayed items.

-Views can show items listed by date, name or subject.

Color

-FirstClass has full support for color, including color icons.

-Icons and pictures may be customized globally by the administrator or locally by end-users.

User Preferences

-Users may configure their own preferences, including sort order, window sizes, etc.

Complete Electronic Mail Facility

Fundamental to electronic communication is the empowering of users to send private mail to other users. 
The integrated groupware functionality of FirstClass conferencing builds on the principles of its e-mail.    
Messages are composed the exact same way with the exact same tools.

MailBox

-All incoming private mail arrives in users' private mailboxes.    Copies of outgoing mail are automatically 
retained in users' mailboxes.

-Users can create and name folders where mail may be dragged to organize their mailboxes.

Easy Addressing

-Users can type a partial name of a recipient into a To:    or Cc:    list and the name is validated and 
inserted instantly.

-There is no limit to the number of recipients a message can have.

File Attachments

-Users may attach any type of file to a message in FirstClass.



-Any number of files may be attached to a given message.

-Messages with attachments are indicated by a small file icon beside them in message lists.

-Attachments are downloaded from a message by double clicking on the attachments themselves.    The 
download takes place in the background, freeing the user to perform other tasks¾which can include other 
downloads or uploads!

-If a user runs out of time or a power failure occurs in the middle of a file transfer, the transfer can resume 
where it left off when reconnected.

-XModem?    ZModem?    Kermit?    MacBinary?    FirstClass uses its own proprietry protocol so you and 
your users don't have to worry about transfer details.

Mail Notification

-Network users can be notified with a sound and/or screen message when new mail has arrived, even if 
they are not logged into the FirstClass server.

-Server provides instant notification of received mail¾client does not have to poll at all.    Cuts network 
bandwidth in large organizations dramatically!

-The FirstClass server and its single file per message structure allow delivery of any message in 
FirstClass in milliseconds, even across platforms.

Electronic Forms

-FirstClass messages may be created and sent using various electronic forms which resemble real-world 
envelopes, phone message pads, requisition forms, etc.

-Forms are useful when combined with gateways: a "fax" form can be used to send complete faxes 
(including your cover page or letterhead) to other fax machines with the optional FirstClass Fax Gateway.

Unread and Unsent Tracking

-FirstClass tracks the status of every message for every user; unread messages can be easily identified 
by an red "unread" flag.

-Messages may be saved but not sent to allow for later work.    Unsent messages are marked with a clear 
flag.

Résumés

-All users have a résumé, a document describing themselves to others, which they can edit.

-Double clicking on a name anywhere in FirstClass calls up the résumé of that user.

Forward/Reply

-Forwarding an item duplicates the message contents but leaves the address blank.    Replying addresses 
a new message to the author of a previous message.

History

-At any time, users can check the history of any message to get a complete list of who has read, replied 
to or forwarded it.

Gateways

-Gateways permit the routing of mail to other FirstClass servers.    These allow you to create networks of 
linked FirstClass systems over network or modem for private mail, conference and file exchange.

-Gateways are also available for sending mail from FirstClass to other mail systems, (such as the 
Internet) fax machines or even pocket pagers.

Conferencing

Conferences are forums that users can read and send messages to.    They appear as icons on users' 
desktops or may be nestled within other conferences, and are perfect for sharing information among large 



groups.    Users can send to a conference simply by addressing mail to it... as if it were another user.

Unread Tracking

-Like private mail, unread items in conferences are tracked on a per-user, per-item basis with red flags.

-The icons of conferences containing unread items are themselves flagged with a red flag.    Users can tell 
at a glance when there are new items to read.

Customizable Setups

-The administrator can create any number of conferences.

-Each conference has a unique name, and can be given a customized icon.

Single Copy Message Design

-Only a single copy of each message and attached file is stored by the FirstClass server, regardless of 
the number of entries in the To: or Cc: fields or cross-posts to conferences.

-Results in a significant reduction in disk use, and greater storage efficiency and speed.

Moderators

-A conference can be moderated so that all submissions require approval by the administrator or a 
moderator.

Conference Security

-The administrator can create conferences that can only be read by a selected set of users.    Other users 
might not be able to open messages in that conference, or even know the conference exists at all 
depending on the administrator's decision.

Chat

-Users may participate in public and private real-time chats with each other.

Access Methods

FirstClass supports access via AppleTalk, modems, the Macintosh Communications Toolbox and Novell 
IPX... all simultaneously without third party software or hardware.    The FirstClass Protocol (FCP) 
architecture of the FirstClass server easily provides for multi protocol support at the server level.    Up to 
250 concurrent sessions of mixed protocols can by accommodated by the single high-performance 
FirstClass server.

IPX Access

-Windows machines may log into the Macintosh FirstClass server with an Ethernet card and IPX driver 
(supplied with most Ethernet cards and Windows 3.1)

-Novell NetWare not required!

-Windows sessions are given the exact same priority by the FirstClass server

-Provides for real-time chatting between platforms and instantaneous message delivery

-Translation provided between extended characters of Windows and Macintosh character sets (like the 
"é" character.)

AppleTalk Access

-Users on an AppleTalk network may access a FirstClass server on the same network.    FirstClass 
supports multiple zones, AppleTalk Remote Access and multiple servers per network.

Communication Toolbox Access

-Full server-level support for the Macintosh communications toolbox allows FirstClass to accept logins 
over a variety of sources... including ISDN, X.25 or ADSP.

Modem Access



-Users not on the network can access FirstClass with any Hayes compatible modem, including high-
speed models offering v.32bis, v.42bis and MNP features.    Performance via high-speed modem rivals 
network performance.

-Modem connections are made with the same FirstClass client used on the network.    No special remote-
access mail client to teach users.

-Modem access for network users is a built-in feature with no extra charge.

-Up to 22 modems per server can be accommodated by FirstClass, with no inherent software limit.

VT-100 Interface

-With the optional Command Line User Interface, any user with a VT-100 terminal emulator can access all 
features of FirstClass and take advantage of a full screen editor for messages.

-Can work over TCP/IP network, if both Macintosh server and Macintosh client are outfitted with TCP 
connection tool.

Administration

Many current electronic mail and bulletin board packages are difficult to install and administer.    FirstClass 
has been designed to take care of itself with very little intervention.    Some sites set their servr up in a 
closet and let it run for months unattended.

Easy Installation

-Installing the FirstClass server takes two disks and less than five minutes.    Installing the client 
application is a matter of dragging a single file or running a simple installation program.

-Other similar programs require upwards of 10 disks to install and offer far less functionality.    (We can't 
explain it either!)

Server-Friendly

-The FirstClass server application runs perfectly on any Macintosh, even a Plus or Quadra.

-Server already in use for file or print services can run the FirstClass server at the same time.

-For system administrators with only a single Macintosh, the FirstClass server can be run in the 
background while the administrator logs in with FirstClass client from the same machine.

Easy Upgrades

-The FirstClass server and client can usually be upgraded in seconds at any time.

-Software upgrades are always free for download from SoftArc.

Remote Administration

-All administration in FirstClass is handled through FirstClass client¾the same software all others use, 
whether their connections are remote or local.

-Allows administrators to log in and check on the system from home or the other side of the country.

-Makes configuring server-to-server gateways trivial, even at a server around the world.

Privileges & Permissions

-The FirstClass administrator can create groups of users with certain privileges and control the access a 
group or user has in any conference.

-Users are easily added or removed from groups.

-The desktops of users in a given group can look completely different and not contain any similar items if 
the administrator chooses to do so.

CD-ROM and External Volume Access

-The administrator can link a CD-ROM into FirstClass.    Users can have complete access to the CD, even 



over a modem.

-Double clicking on an item on the CD-ROM can initiate download can be started.

-Users may search CD-ROMs.

-Similar links can be made to any hard drive, or any folder on any hard drive, connected to your server or 
accessible to it over a network.

-The whole server's drive may be linked to the FirstClass administrator's desktop, allowing access to any 
file on the system

Auto Registration

-If the "Auto Register" feature is enabled, new network or telecom users can fill out an on-line form and 
register themselves without the administrator's help.

Robust Server

-Tired of servers that go down?    The FirstClass server doesn't, and we have thousands of customers 
who can guarantee it.

Auto Deletion

-All private and conference messages in FirstClass are assigned a deletion date when created and are 
automatically removed after that date in automatic server housekeeping.

-Disk space isn't wasted by out-of-date messages and the administrator's workload is substantially less 
than with other systems.

Low Memory Requirements

-The basic FirstClass server requires less than 1 megabyte of free memory for operation.    The FirstClass 
client requires only 600k.    FirstClass will run on any machine in your office!



Setting Up A FirstClass System
Before purchasing FirstClass, one should have a good grasp of exactly how the system will be used and 
how many people will be using it.    Do you intend to use FirstClass simply as a network e-mail and 
conferencing product?    If so, your selection is easy.    Do you wish to allow remote access for people to 
check their mail?    If so, how many incoming lines would you require?    Do you want to use FirstClass 
primarily for technical support with your customers, with a minimum of network access?    Do you want to 
use FirstClass simply as an outstanding graphical BBS?

Client And Server Issues

The FirstClass server will run on any Macintosh with at least two megabytes of memory under System 6, 
or four megabytes of memory under System 7.    A Mac Plus or better is recommended as the minimum 
one would want to use for your server.    The FirstClass server is exceptionally high-performance software, 
and will offer you impressive results even on a Plus.

A Mac Plus may accommodate as many as 20 simultaneous network users and one modem session.    
This means 20 people in your office could be checking their mail at the same time over the network 
(regardless of how many people in your office actually use your FirstClass system everyday) and one 
person could be logged in by modem.

FirstClass may be run on a non-dedicated Macintosh.    However to minimize potential conflicts with the 
FirstClass server and not compromise reliability, SoftArc recommends the server machine be kept free of 
INITs and foreign system extensions.    However, the FirstClass server can be run on the same machine 
as an AppleShare 3.x fileserver without conflicts for example, or on a print server or FileMaker Pro server.

If you require more than 20 simultaneous network sessions, consider a faster machine like a Mac II of 
some sort.    A Mac II or IIx can offer you more than 100 simultaneous sessions.

If you need to accommodate more than one or two modems simultaneously, you'll need a Mac II for its 
NuBus expansion slots.    While it's possible to accommodate two modems on the same non-NuBus Mac 
at the same time, Apple does not recommend you use anything over 2400 baud.    Also, you'd need to 
forego any AppleTalk access to your server, because the printer port must be kept free for AppleTalk... 
even when logging into the FirstClass server with the FirstClass client running on the same machine 
(normally possible.)

All this points to a Mac II or Quadra machine with spare NuBus slots, with which to accommodate the 
Multiport Server Upgrade packages SoftArc sells if you need more than one or two modems.

Each multiport upgrade includes a Creative Solutions "Hurdler" NuBus card, which may drive up to four 
high-speed modems without difficulty due to reliable on-board processing.    Each upgrade package also 
includes the software one requires to upgrade the licensing of a FirstClass server so it may "see" the 
NuBus board and allow extra modem sessions to be configured on it, and four high-speed hardware 
handshaking modem cables.

One requires a Multiport Server Upgrade for every four modems one wishes to install on a FirstClass 
server.    Current hardware limitations only allow FirstClass to accommodate up to 22 modems, but there 
is no limit inherent in the software.

Choosing Modems

FirstClass will work reliably with any Hayes-compatible modem once configured properly.    Modem 
configuration is performed by selecting a modem configuration file via a pop up menu listing popular 
models on both the client and server.    If a given modem is not listed, it is sometimes necessary to edit 
the default modem strings and enter some of the modem's perculiar commands.

Both the FirstClass server and client take advantage of "hardware handshaking", a process by which the 
Macintosh makes up for deficiencies in the number of pins in its serial ports when using high-speed 
modems.    When using a high speed modem with either the FirstClass server or client, it's important to 
ensure the modem has been plugged in with a "hardware handshaking" cable with the carrier-detect pin 



enabled (although not all Macintoshes recognize carrier detect at their serial ports.)    SoftArc sells these 
cables, and includes them for free with every system purchase and every Multiport Server Upgrade.

If hardware handshaking cables are not used and the proper modem configuration file has not been 
selected, FirstClass may not properly negotiate connections between high-speed modems and default to 
a lower (usually 2400 baud) connection.

FirstClass insists on hardware handshaking, while other terminal programs or communication packages 
may not, so as to deliver the fastest, most reliable connection yet still offer its advanced communication 
features like simultaneous multiple file upload and download.

Regular Vs. Telecom Users

It's easy to budget for how much you have to pay for the FirstClass client and server.    They're free!    
When you purchase a FirstClass system, you pay for the license to accommodate however many users 
you require.

As mentioned earlier, the FirstClass client is freely distributable.    But the FirstClass server, while free, is 
not distributable.    Nor are the license diskettes purchased with a FirstClass system.

Users are available in two classes in FirstClass: regular users, who may access your system via network 
or modem, and telecom users, who may connect with your server by modem only.    Regular users are 
those you'd purchase when using FirstClass internally.    Telecom users are available for companies who'd 
like to extend access to their FirstClass system to large numbers of their customers, or for groups or 
individuals who would like to use FirstClass as a BBS.

Packages of regular users are available starting at quantity five, all the way up to quantity 5000.    The 
cost per user is $79 at five, and drops to $15 a user at 5000.    Packages of telecom users are available 
starting at quantity 100, up to quantity 5000.    Per user, they start at $4 and drop to $1.50 at quantity 
5000.    (Even in minimal configurations, FirstClass is considerably cheaper than other e-mail or 
conferencing packages.)

An exact itemization of license limit packages is available in our formal price list, posted elsewhere in this 
area.

Lastly, user licensing is cumulative.    Those who purchase a 10 network user package, say, and need to 
upgrade to 25 users later must purchase an additional 10 user package plus a 5 pack, rather than just 
paying the difference in price between the 10 and 25 user package prices.

What Comes In The Box?

When ordering a FirstClass system, one receives the server and Macintosh client diskettes in addition to 
a license disk(s) for whatever number of users one has purchased.    Also in the box is are single copies 
of each of the client user manual and administrator reference manual¾a total of about 350 pages of 
documentation.    Finally, a series of quick-reference cards which may be freely copied and distributed are 
also included, as are a hardware handshaking modem cable and basic information on FirstClass and 
available options.

When ordering simply a user upgrade to an existing FirstClass server, one receives only the diskette.

Extra copies of the FirstClass user's manual and administrator's guide are available for the amounts 
indicated on our price list.

Options

The following cursorily indicates which optional products one requires to fulfill specific communication 
needs with FirstClass.

Organizations requiring multiple servers will be pleased to discover FirstClass servers come complete, 
right out of the box, with the ability to talk to each other and exchange mail and conferences via network 
or modem.    Mail, conference and file exchanges are done bidirectionally... reducing phone bills by up to 
50% if connections are made by modem.

A popular option for those opening their servers up for remote access is the FirstClass Command Line 



User Interface.    This software module installs on the FirstClass server in seconds, and enables modem 
logins from users without the graphical FirstClass client software (they may then download it from your 
system if you make it available.)

Also popular is the Windows User Interface, which allows users of Microsoft's Windows operating 
environment to log into FirstClass systems via modem with SoftArc's FirstClass client application for 
Windows.    Sites wishing to accommodate Windows users on their networks require the IPX Connection 
Option as well as the Windows Users Interface.

A variety of gateways from FirstClass to other systems and services are available.    Internet connectivity 
for private mail and Usenet Newsgroup replication within FirstClass conferences is handled by way of a 
software product called "PostalUnion Deluxe" or its UUCP dialup version "PostalUnion UUCP".    
Gateways are available from FirstClass to foreign mail systems like Microsoft Mail® or QuickMail®, a 
variety of systems through our Novell MHS gateway or the world of fax machines with SoftArc's FirstClass 
Fax Gateway.

Full descriptions of all of these options are available.



FirstClass Price List
You may choose between two classes of users for your FirstClass system: regular users who can access 
the system via network or modem and telecom users who may access via modem only.    You may 
configure your system with both regular and telecom users to meet your requirements.    All systems 
include manuals and quick-reference cards.    Additional copies may be ordered.

To accommodate more than two modems you will require a multi-port server upgrade package, listed 
below.

Overnight shipping and handling charges are also listed below.    SoftArc only ships packages overnight.

REGULAR USER PACKAGES:
    5 Regular User Pack $395.00
   10 Regular User Pack $595.00
   25 Regular User Pack $995.00
  100 Regular User Pack $2595.00
 

TELECOM USER PACKAGES:
  100 Telecom User Pack $395.00
  250 Telecom User Pack $595.00
  500 Telecom User Pack $995.00
 1000 Telecom User Pack $1595.00

OPTIONAL UPGRADES:
 Command Line User Interface $295.00
 Windows User Interface $295.00
 IPX Connection Option $495.00
 Postal Union (Internet Gateway) $1995.00
 Postal Union UUCP (Internet Gateway) $695.00
 Postal Union/MS (Microsoft Mail® Gateway) $495.00
 Postal Union/QM (QuickMail® Gateway) $495.00
 FirstClass Fax Gateway $495.00

HARDWARE PORT EXPANSION:
 Hardware Handshaking Modem Cable $25.00
 Multi-port Server Upgrade Package $895.00
  - Includes software, 4-port serial card,
    and 4 HH cables

DOCUMENTATION:
 Macintosh User Manual $10.00
 Windows User Manual $10.00
 Administrator Manual $50.00
 Quick Reference Cards (quantity 5) $10.00

SHIPPING & HANDLING:
 Canada $25.00
 USA $35.00
 Europe (EEC & EFTA) $70.00
 Elsewhere $90.00

Educational and hobbyist BBS pricing available upon request.



This price list effective 93/05/03.    SoftArc Inc. reserves the right to change this price list at any time 
without notice.    FirstClass is a registered trade mark of SoftArc Inc.    Microsoft Mail is a registered 
trademark of Microsoft Corporation.    QuickMail is a registered trademark of CE Software Ltd.



About The OneNet Network
The OneNet Member Network is an organization of private individuals around the world who own 
FirstClass systems and have chosen to hook them together to regularly exchange mail and conferences. 
While OneNet members use FirstClass and take advantage of its built-in gateway features, the OneNet is 
completely arm's-length from SoftArc¾which has nothing to do with its operation.

The OneNet is rapidly developing largely through the efforts of BBS administrators worldwide.    It is 
creating an online, virtual community of people connected to share knowledge and resources.    This effort 
is expanding into an electronic nervous system throughout the world.

Based from a large BBS in Los Altos, near Apple's Cupertino headquarters, the OneNet Member 
organization has begun tying together not only individual BBSes, but schools, hospitals, universities, local 
governments and other FirstClass networks.

The OneNet Member goal is to serve as one of the methods to glue the various networks in the world 
together into a system based around low cost servers, networks, laptop computers and upcoming 
Personal Digital Assistants.    Looking to the future,The OneNet hopes to do for electronic information 
exchange what the Macintosh earlier did for computing¾that is, to make telecommunications fun and 
easy.    The FirstClass software's familiar graphical graphical human interface makes this goal and 
prospect possible.

Setting up as a OneNet Member is easy for both the FirstClass BBS administrator.    A core set of 
conferences is shared by all systems in the network and contains discussions of interest to all computer 
users.    These conferences cover a wide variety of topics and include networked support conferences 
from many computer industry vendors, including SoftArc Inc., developers of FirstClass.    One of the most 
popular conferences on the network is one in which Apple employees routinely log on to give unofficial 
advice to other users.    Gatewaying systems can pick their choice of conferences they wish to carry from 
the backbone hub systems, which already distribute more than 100 forums (much as a magazine 
distributor gives retailers many choices from which to pick.)

The OneNet Member network now includes more than 130 systems across the United States and 
Canada, and systems in Europe with sites in Norway, Germany, and Switzerland.    There are now 
systems in Japan on the network.    The total user base is estimated at more than 80,000 people.

Some BBSes in the OneNet Member Network already offer gateways to InterNet and FidoNet, whose 
inclusion fosters OneNet's goal of electronic community. Future plans for the growing network will make 
the sharing of information increasingly less expensive for both public and private systems as they hook 
into the network to share in this vast pool of resources

To learn more about the OneNet, call the OneNet Los Altos flagship system by modem at 415-948-1349. 
For additional information, contact the OneNet voicemail system at 415-948-4775, or mail inquires to:

OneNet Los Altos
4546 El Camino Real, # 127
Los Altos, California
94022
USA

Scott Converse, Executive Director, OneNet Member Network
Contact via modem @ 415-948-1349, via voice line @ 415-948-4775

May 1993, Los Altos, California



Customer Endorsements & Media Remarks
Many of our customers upon discovering FirstClass are pleasantly surprised at what the product actually 
does and how it performs!    This goes as well for the media... more and more of which are discovering 
and writing about FirstClass every month.

"Those in charge of complex communications operations have a simple plea: Can't all of the bulletin 
board, E-mail and other on-line functions be integrated, if not in a single product, at least by way of a 
single product? ... FirstClass from SoftArc Inc. comes about as close as you can get."

MacWEEK, April 5th, 1993

"Your software just arrived and I have seen the future."

Lee Konowe, Ph. D., President, PsychNet, Inc.

"I just wanted you to know how pleased we are with FirstClass.    Your system meets all of the 
requirements my users had and seems to have been made for them, and has good response times.    I 
congratulate your company on a job well done and I look forward to using FirstClass for a long time."

Michelle Hart, Ayuda Network, Mariana Islands

"We used to use MS Mail, but dropped it in favor of FirstClass...    now I can't imagine not using FC as an 
E-mail system.    With 9 incoming lines and the Notification init to tie network and outside calls together, 
it's the only way to go."

Keith Raynor, Scarborough Board of Education, Ontario, Canada

"... I'm very pleased with the stability of the software.    And the interface... It still amazes me. ... Nice 
work."

Pete Johnson, private system owner

"This is the first graphical user interface (GUI) BBS that really works.    There have been other GUI 
BBSes, but none have been as easy to use as FirstClass."

Spring 1993 Berkely Macintosh User Group Newsletter

"Thanks for a GREAT system.    We are expanding county wide and also using it to communicate with 
state and federal agencies as well as out of state fire service agencies."

Al McMahen, Marion County Fire Department, Oregon, USA

"We've given up on QuickMail and started using FirstClass for customer support and file transfer with a 
few willing clients, and I've noticed something: everyone loves it!    Our customers are very impressed with 
the system..."

Dave Caplinger, Orent Graphic Arts, Omaha, USA



"FirstClass is faster than Microsoft Mail, faster than copying across zones to AppleShare servers and 
much faster than using Shiva remote dial-in.    We've encountered nearly zero comm failures and have 
had not even one server crash since upgrading...    Congratulations to the entire team!"

Bill Lunnie, General Electric head office

"We now have had your FirstClass software on line for approximately 2 months ... and it has performed 
flawlessly.    We have been delighted with its performance."

Mike Cross, Motorola Paging Division

"Over 1500 callers use our system to communicate with other teachers and students across North York.    
One of my callers told me 'the Mini-Manual is put aside in 30 minutes...never to be used again.'    This is 
computer telecommunications unlike anything you might have seen before."

Rob Brown, North York Board of Education, Toronto, Canada

"All I can say about FirstClass is that it makes my BBS something special, something worth calling and 
spending time on.    My callers love it.    I love it.    That's it."

Maria Langer, Prominent Macintosh Author



Contacting SoftArc
SoftArc Inc. can be reached via mail, fax, phone, and through most major on-line services.    Please 
contact SoftArc at one of the following;

Mail: SoftArc Inc.
805 Middlefield Road, Suite 102
Scarborough, Ontario, Canada
M1V 2T9

Phone: 416-299-4723

Fax: 416-754-1856

CompuServe: 70511,2065

America Online:SoftArc

Internet: sales@saolgate.softarc.com

AppleLink: CDA0674



Additional Customer Support
Your Administrator should be able to solve any problems you encounter; use FirstClass's mail system to 
request assistance or report any problems by addressing them to Administrator.

In addition, SoftArc Inc. runs its own FirstClass system, SoftArc Online, for customer support. The system 
is available twenty-four hours a day for any user to log in and register. Our conferences answer 
commonly asked questions and contain many hints and tips from experienced FirstClass users. The 
number for SoftArc Online is (416) 609-2250. You can log in as User ID "guest" with no password if you 
would like to try out the system or ask questions in public areas. Auto-registration is available so you can 
log in as yourself using your favourite User ID and password if you plan to call more than once.



What You Need
FirstClass is a "Client/Server" system. This means that you need software at both ends to run the system. 
As a user of FirstClass, you are the client and require the following to use FirstClass:

A computer running Windows 3.1 (or later) software.

At least 1.2 megabyte of free storage on your hard disk.
(To check this, choose the File Manager icon in the Main group, then choose the icon for the hard 
disk drive you want to check. The amount of available storage is shown, in bytes, in the status bar 
at the bottom of the File Manager window. If the status bar does not appear, choose Status Bar 
from the Options menu.)

At least 4 megabytes of memory.
(To check this, use the "mem" command at the DOS prompt.)

A link to a FirstClass Server (either a network connection, using an IPX-capable card, or a 
modem).

This manual will assume that you are familiar with the operation of your computer's operating system. If 
the operations of dragging, selecting, and other basic concepts are new to you, we suggest you go 
through the guided tour or online tutorial that came with your computer or operating system.



Starting the FirstClass Application
The easiest method to connect to FirstClass is to open up a settings document. The Settings directory 
contains several settings documents already configured; copy one of them and modify it for the FirstClass 
system that you want to access. Double-clicking on the settings document automatically starts the 
FirstClass Client application and the Login dialog is displayed:

From here, you "login", or connect, to the FirstClass server. Type your User ID, which uniquely identifies 
you to FirstClass, then press the tab key and enter your password. The password ensures that only you 
can access your private mail and files.
Before you click the Login button, you may need to configure several parameters in order to connect 
properly with your system. To do this, choose Service Setup from the Service Menu. The Service Setup 
dialog appears:

The most important setting to configure is your connection method, by selecting the appropriate Connect 
File. The FirstClass Client can connect using an IPX-compatible network connection or modems.

Fill in the UserID and Password fields so that you don't have to enter them the next time you open the 
settings document. Logon Automatically means that you don't have to click the Login button when you 
open the settings document. The Retry and Retry delay fields can be used for repeatedly dialing a busy 
system.

If you are accessing the server over a network, fill in the Server and Network name. If you are accessing 
the server via a modem, fill in the telephone number. If you are connected to a PBX in an office, you may 
have to enter a "9" (or other special dialing prefix) followed by a comma to dial out correctly.

Click the Save button to save these settings.

The next two sections describe how to log into FirstClass via an IPX-compatible network connection or 
modem. You might want to skip the unnecessary section and just review the section you will be using.



Connecting Via IPX-compatible Network
To set up the configuration parameters necessary to connect to the server over a network, select 
Connection Setup from the Service menu. The Connect File Setup dialog appears:

Select the IPX protocol from the Protocol popup (and disregard the rest of the settings on the form). Click 
the Save button to save these settings.
At the Login dialog, click Login to initiate a network connection to the FirstClass server. Your FirstClass 
desktop appears on your screen.



Connecting Via Modem
To set up the configuration parameters necessary to connect to the server using a modem, select 
Connection Setup from the Service menu. The Connect File Setup dialog appears:

Choose Serial from the Protocol pop-up menu. Select the modem script that is most similar to your 
modem. Select the port your modem is connected to, indicate whether you have a Pulse or Tone 
telephone line, change the baud rate if necessary, and fix the volume if appropriate. Select the 
appropriate settings in the remaining fields, then click Save to save these settings.
At the Login dialog, click Login to initiate a modem connection to the FirstClass server. Your FirstClass 
desktop appears on your screen.
For a more detailed description of modems, refer to the section entitled Modems.



The Desktop
After successfully logging on, you see your FirstClass desktop:

The desktop window is always displayed when you are connected to FirstClass. The following important 
icons are displayed on your desktop:

Mailbox: Your mailbox is your own private area. Mail 
items are created, sent, and stored here. You can also 
create folders to help organize your messages.

News: The News conference is a public area that 
everyone on FirstClass has access to. Your 
Administrator may use it for urgent or priority 
messages. Since News is on your Desktop, you can 
quickly find out any new information from the 
Administrator.

Conferences: Conferences is a folder that contains 
other public conferences on your FirstClass system. 
Look in here for general-purpose information and 
topics.

Help: The Help folder contains a complete online help 
system that will give you more information about your 
FirstClass system. You may use the Help files as an 
online reference system.

You may also find the following items on your desktop:

Folders: Folders in FirstClass are identical to their 
counterparts in the Macintosh Finder, and are similar to 
directories in Windows. They are used to store related 
items together, and can contain any items, including 
other folders.

Files: Files can be used to keep reminders or lists of 
items, and are completely private.

Chats: Chats are conversations that take place via the 
keyboard between users. Using Chat, users can 
quickly exchange short messages and get immediate 
feedback.

Note that the exact appearance of your desktop may vary, since FirstClass may be customized by your 
system's Administrator.

Related Topics:
Palette



Palette
Quick and easy access to many FirstClass messaging commands is available on a palette. Choose 
Palette from the Window menu, and the palette appears. You will see references to the palette buttons 
throughout the next two chapters. See the section on the Palette for more information.



Reading Your Mail
When you open your mailbox by double-clicking on the mailbox icon on your desktop, a message 
summary is displayed. Your mailbox contains both your incoming and outgoing private messages: 

The summary lists the sender or recipient of the message, the size, the subject, and the date the 
message was sent or received.

The following flags are used to draw attention to certain messages:

A solid flag indicates that the message is unread, meaning 
that you have not yet opened this message.

A hollow flag indicates that the message is unsent, 
meaning that you have created the message, but not yet 
sent it.

A file flag indicates that the message has files attached to 
it. For more information on attachments, see the 
Attachments and File Transfer Sending Messages With 
Attachments chapter.

To open any message, simply double-click on that message. The message is displayed in a new window:

Double-clicking on a name in the To: or Cc: field (if one exists) displays the person's résumé.

Note that the window is divided into two panels. The upper panel contains the envelope information (such 
as the sender's name, a list of recipients, the time and date of sending, etc.). The lower panel contains 
the content of the message. Separate panels enable you to scroll the message and the envelope 
independently of each other, which is useful when the envelope is very long.

You may move the split bar between the panels by dragging it with the mouse: just position the cursor 
over the split bar and when the cursor changes, drag the split bar to re-adjust the panel sizes.

To close the message window, click on its close box in the upper left corner.



Sending Mail To Other Users
Private messages, or mail, can be sent by any FirstClass user to any other user. To create a new 
message, follow these steps:

1. Choose New Message from the Message menu. A new, unsent message entry is created in your 
mailbox and the following message window appears.

Your name is 
automatically 
inserted into the 
From: field when 
you create a new 
message.

You can also click the New Message button on the palette 
to create a new message.

2. Type a subject for the message and press enter. The cursor moves to the To: field, ready for you 
to address the message.

3. In the To: field, type the name of the person you are sending the message to. When you press 
enter, FirstClass searches for the name in its User Directory.

You can enter a complete name such as "Scott Appleton"; a last name only, such as "Smith"; or 
even a first name, like "Colin". If a single matching name is found, the full name replaces 
whatever you have typed.

If more than one name is found, FirstClass displays a list of all the names that match and allows 
you to select the names you want by shift-clicking.

To enter the selected names into the address list, just close the directory window and they are 
automatically pasted in.
4. Enter names in the Cc: field if you wish to send copies of the message to additional users.

5. Enter the content of the message by clicking the mouse into the lower portion of the message 
window and typing. (You may also use the F6 key to move into the lower panel.)

6. If you are ready to send the message, choose Send from the Message menu. If you close the 
message without sending it, FirstClass warns you that the message has not been sent, and gives 
you the option to send it:

Click the Send Now button to send immediately. If you don't want to send the message (perhaps you want 
to work on the message later), click the Don't Send button. The message is kept in your mailbox with an 



unsent flag on it to remind you that it has not yet been sent. Clicking the Cancel button returns you to the 
message.

You can also click the Send button on the palette to send 
the completed message.

When a message is sent, a Postmark is automatically 
put on the top right portion of the message. The 
postmark indicates that the server has received the 
message and has begun delivery to the recipients.

Replying To Messages
You can respond to any message by replying to it. When you choose Reply from the Message menu, 
FirstClass automatically creates a new message with the From:, Subject:, To:, and Cc: lists filled in with 
information from the currently open or selected message.

The message is re-addressed to the original sender of the message, and the original Cc: names are 
retained. "Re :" is automatically inserted before the original subject.

Once you have typed in the new message, you can send it.

You can also click the Reply button on the palette to reply 
to messages. The message you are replying to must be 
open or selected before you click the palette button.

Forwarding Messages
You may resend a message to another user or conference using the forward feature.

When you choose Forward from the Message menu, FirstClass duplicates the contents of the currently 
open or selected message, including attachments, but allows you to re-address it. "Fwd: " is automatically 
inserted before the original subject.

Once you have re-addressed the message, you can send it to the new recipient(s).

You can also click the Forward button on the palette to 
forward messages. The message you are forwarding must 
be open or highlighted before you click the palette button.

Message History



Once you have sent mail to another user, it is very useful to know whether they have received the 
message and read it. This is easily accomplished in FirstClass by using the History feature on a message.

To display the history for any message in your mailbox, just select the item and choose History from the 
Message menu:

You can use the history to find out when a message was created and sent, who has read the message 
and when, whether any attachments have been saved, and if the message has been replied to or 
forwarded.

You can also click the History button to view the history. 
The message you are requesting history on must be open 
or highlighted before you click the palette button.

File Folders
To clean up your mailbox, you might want to organize some of the messages so that you can refer to 
them later on. FirstClass allows you to create folders in your mailbox or on your desktop for exactly this 
purpose.

To create a folder in your mailbox, go into your mailbox and choose New Folder from the Conference 
menu. To rename the folder, choose Get Info... from the File menu. Change the Name field and click OK 
to save the name.
You can create multiple folders in your mailbox and also folders within folders. To place messages in 
folders, simply drag them using the mouse. You can also shift-click to select multiple messages and drag 
all of them into the appropriate folder.



Deleting Messages and Folders
If you receive many mail messages, your mailbox can quickly become cluttered. To delete messages from 
your mailbox, select the messages you want deleted (shift-click to select multiple messages) and choose 
Delete from the File menu.

Before actually deleting the messages, FirstClass will ask you to verify that you want to delete the 
selected items:

Click Delete to delete selected items, or Cancel to cancel the delete.
You can delete folders in exactly the same way you delete messages: highlight the folders and choose 
Delete from the File menu.
Messages also have an expiry date automatically assigned and will be deleted after that date. See the 
Get Info section for more information.

You can also click the Delete button on the palette to 
delete messages and folders quickly and easily.

Using Gateways
Gateways allow you to send messages from one FirstClass system to another, or from one FirstClass 
system to a third-party mail system such as CompuServe or Internet. You can also use gateways to send 
mail to distant users who may never call your "home" server directly.

Using gateways requires only one additional step: providing a gateway name. For instance, if you wanted 
to send a message to Ian Faith on SoftArcOnline, you would choose New Message from the Message 
menu and address the letter by typing in his name, followed by a comma, and then the name of the 
gateway.

Since Ian Faith is 
found on SoftArc 
Online, you 
would type "Ian 
Faith, SoftArc 
Online" as the 
address.

Gateways can also "bridge" to other systems not running FirstClass. For example, 
"75311.2023,CompuServe" would send a message to a user identified as 75311.2023 on CompuServe 
through the FirstClass to CompuServe Gateway (if such a gateway is installed on your local FirstClass 
server). "775-7308,fax" would send a fax to that phone number, via a fax gateway.

When using a gateway, FirstClass does not validate the name of the user you are sending a message to. 
This is because FirstClass only knows about the items on its system, not those on other systems. Thus, 



your server cannot validate the name of a remote user, but it can validate the name of the gateway used 
to get there.

Since the local FirstClass system can only validate the gateway names, you could end up addressing 
messages in such a way that they will not be deliverable at the "far end". This would be the case if the 
user does not exist, or there are several users that match the given name. These return messages are 
called NDN (Non-Delivery Notification) messages:

If your message cannot be delivered, an NDN will be returned to you with a description of why the original 
message could not be sent.



Sending Forms
FirstClass supports special messages called forms. You can compose and send forms just like normal 
messages, but they can also contain fill-in fields, check-boxes, underlining, font changes, and graphics. 
Each FirstClass system includes several standardized forms to choose from, including File Transfer, 
Phone Call (shown below), Request For Information, and a Requisition Form.

To use a form, choose New Form from the Message menu, then select the form you wish to send from the 
sub-menu.

To send the form, choose Send from the Message menu. Just like normal messages, you can also click 
on the close box to send.



Conferences
Conferences are forums or bulletin boards which are generally focused on a single topic. For example, 
there might be a conference that contains items dealing with a particular type of software, or a specific 
product. By reading these conference items, you can stay abreast of information you are interested in.

Opening the Conferences icon on the desktop displays the contents of the Conferences Folder. In this 
folder you will find all of the public conferences that are available on your system. There is a second type 
of conference; the private conference. If you have access to any private conferences, their icons will also 
appear on your FirstClass desktop.

® A Note about available conferences... The specific list of conferences available on your system will 
depend on the special interest groups within your user community. If you think that there is a 
need for a conference and you don't see it, your Administrator can set up a new one for you.

If you are interested in a conference, open it by double-clicking on its icon. FirstClass shows you which 
conferences contain items that you have not yet read by putting an unread flag beside the icon.

® A Note about conference information... If you are curious about the contents of a specific conference, 
you can select the conference and choose About Conference from the Conference menu. This 
will bring up a window that contains a brief description of the conference. You may also double-
click on the name of a conference in any message to display this information.



Browsing Conferences
When you open a conference, a summary of the items in the conference is displayed:

This summary is just like your mailbox summary. Items that you have not yet opened are marked with an 
unread flag ( ) and any that have attachments are marked with an attachment flag (

). You may open a conference item by double-clicking on it, as with messages in your mailbox. To close 
any conference items and windows, click on their close boxes.
Depending on the conference, you might see conference items that are italicized. This means that the 
item must first be reviewed and approved by a designated "approver" before other users are allowed to 
read it.

® A Note about Attachments... Attachments are files that are attached to a message and may be 
transferred to your computer. Attachments are one of the most useful and powerful features in 
FirstClass, because they allow you to share files with other users. For more information, read the 
section on Attachments and File Transfer.



Sending Messages To Conferences
Sending a message to a conference is very much like sending mail to users. The only difference is that 
when filling in the To: or Cc: field you enter the name of the conference you wish to send to.

The following example has To: and Cc: lists that are addressed to several users as well as the News and 
FirstClass Suggestions conferences.

FirstClass treats mail to users and conferences in exactly the same manner. You will even find the 
conferences listed in the Directory. 
Note: If you create a new message while in a conference, it will automatically be addressed to that 
conference.



Replying To Messages
You can respond to any message in a conference by replying to the message, just like in your mailbox. To 
reply, choose Reply from the Message menu. FirstClass automatically creates a new message with the 
From:, Subject:, To:, and Cc: lists filled in appropriately:

When replying in a conference, the To: list contains the name of the conference instead of the original 
creator of the message. Any users that were in the Cc: field are automatically inserted into the new 
message as well. Once you have completed the message, you can send it.

You can also click the Reply button on the palette to reply 
to messages. The message you are replying to must be 
open or selected before you click the palette button.

Forwarding Messages
Just like forwarding private mail to other users, you may forward conference messages to other users or 
conferences.

When you choose Forward from the Message menu, FirstClass duplicates the contents of the currently 
open or selected message, including attachments, but allows you to re-address it.

The new message has the same content as the original but, other than the subject name, has an empty 
envelope. After you fill in the envelope information you may edit the body text and then send it.

You can also click the Forward button on the palette to 
forward messages. The message you are forwarding must 
be open or highlighted before you click the palette button.

Subscribing to a Conference
If you look at a particular conference frequently you may wish to subscribe to it. Subscribing to a 
conference places an alias of that conference on your desktop and provides a short-cut for opening the 
conference. Instead of navigating through various conferences and sub-conferences, you can just double-
click on the conference alias on your desktop. Also, if there are unread items in the conference, the 
unread flag is displayed next to the alias.

To make an alias to a conference, click on the conference and choose Make Alias from the Conference 
menu:



In this example, we have subscribed to the Useful Software conference. A copy of the Useful Software 
icon is placed on the desktop: note that this particular conference has an unread flag to indicate that the 
conference contains some new items. You can delete a subscription by selecting the alias and choosing 
Delete from the File menu.



Open Unread
FirstClass provides a quick way to sequentially open unread messages in your mailbox or a conference. If 
there are any unread items in the current window you simply choose Open Unread from the Conference 
menu. The system finds and opens the next unread item automatically. When you choose Open Unread 
again, the next unread message is displayed in the same window, which allows you to size the window to 
your liking and not have to re-size it again. 

You may step though all the unread items in a conference or your mailbox in this way, and when you 
reach the last unread item, FirstClass will beep. If there are any conferences within the current 
conference that have unread messages in them, you will then start reading the unread messages in those 
conferences.

Open Unread is particularly useful if you have subscribed to your favourite conferences. As soon as you 
open your Desktop, you can select Open Unread, and step from conference to conference quickly.

®Shortcut... To turn off the unread flag without reading the message, you can hold down the Ctrl key 
and click on the unread flag. To turn off the unread flags for all messages in a conference, hold 
down the Ctrl key and click on the unread flag beside the conference icon.

You can also click the appropriate buttons on the 
palette to navigate forwards and backwards through 
unread messages.

Threading
A "thread" is a series of messages related to one topic, starting with the first message on a topic, and 
following through all the replies to that message. By following a thread from one reply to another, you can 
quickly read all the messages on any given topic.

For example, you might write a message about "Unread Flags". Several people reply to your message 
(using Reply), and this creates a thread on Unread Flags.

Threading makes it extremely easy to track down the replies to your problem, even in a busy conference. 
You can use threading in your mailbox too, although it is more useful in conferences.
FirstClass can follow a thread starting at any message and moving in either direction. To follow a thread 
from the beginning, select (or open) the first message in the thread, and choose Next in Thread from the 
Conference menu to see the first reply to the message. Continue selecting Next in Thread to step through 
each reply until you reach the end of the thread.

You can also click the appropriate buttons on the 
palette to navigate forwards and backwards through 
threaded messages.

Deleting Messages in Conferences
Unlike your mailbox, you cannot delete any message in any conference. The only messages that you are 
allowed to delete in conferences are messages that you created and sent.

You delete a message in a conference by selecting the message and choosing Delete from the File 



menu. You will be prompted to verify your request:

You can also click the Delete button on the palette to 
delete a message. By shift-clicking, you can select multiple 
messages to be deleted.

Message History in Conferences
Using the History feature on a conference message, you can quickly see who has read your message 
and who has downloaded any attachments. To display the history for any message in a conference, just 
select the item and choose History from the Message menu:

The history can show when the message was created and sent; who has read, forwarded, or replied to 
the message; and who has downloaded any attachments.
The history on conference items can often be quite long since a large number of people may access the 
conference.

You can also click the History button on the palette to view 
the history. The message you are requesting history on 
must be open or highlighted before you click the palette 
button.

Reading Messages With Attachments
Some of the messages and conference items you read will have attachments. You can tell if a message 
has attachments, because it has an attachment icon ( ) in the summary list and an Attachments: list 
appears in the envelope:

To obtain the attachment(s) and store them on your disk, open the message and select the attachment 
you want. Next, choose Save Attachment from the File menu. From the file dialog box, choose the 
destination folder and filename on your computer. Click Save and the file transfer from the server to your 
computer begins.

® Shortcut... You can obtain an attachment by double-clicking on its name. This is useful if there are 
multiple attachments.

The File Transfer Progress 
window gives you the status 
on the transfer. When the 
transfer is complete, this 
window disappears. (Note that 
you can move this window by 



dragging it).

® A Note about Background Transfers...    Since transferring files from your computer to the server can be 
a time-consuming process, especially when using a modem, FirstClass performs the transfer in 
the background. This means that you can do other things, such as read your mail or browse 
conferences, while the transfer is taking place.

If you want to cancel a file transfer while it is in progress, just click on the close box of the File Transfer 
Progress window. You can continue the transfer later on if you wish. This is described in more detail later 
in this chapter, in the section Resuming File Transfers.



Sending Messages With Attachments
When you edit an unsent message, you may attach a file by choosing Attach File... from the File menu. A 
file dialog box appears, allowing you to search your computer for the file you wish to attach. You can 
attach any file that is on your computer, including graphics files, word processor files, sound files, etc.

Select the file you want from the standard file dialog, and click the Attach button. The file will then be 
attached to your message.
While the file is being sent to the server, the File Transfer Progress window shows you the status of the 
transfer. When the transfer is complete, the window disappears and you are notified by the file completion 
sound (typically a beep).
Your file is now included in the list of Attachments on your message. The figure below shows a message 
with attachments. The name of the attached file is shown in the list of attachments in the envelope portion 
of the message. You can attach as many files as needed.

If you try to Quit from FirstClass while a file transfer is in progress, a dialog box asks you if you would like 
to abort the file transfer:

Click the Abort button to exit FirstClass or the Cancel button to stay connected. If you decide to abort the 
file transfer, you can resume the transfer later on. This is discussed in more detail later in this chapter 
under Resuming File Transfers.



Bi-Directional Transfers

FirstClass allows transfers to take place in both directions at the same time. If you wish to send a file to 
the server, you can start a transfer when you first log in, then use the system as you would normally.

While the upload is taking 
place, you can go to 
another message and 
select a file to be 
downloaded to your 
computer.

Multiple Transfers

FirstClass can have any number of transfers taking place at the same time. Only one of these in any 
direction is actually active; as soon as it finishes, the next in turn starts. If you wish to make a different 
transfer active, click in its transfer window to bring it to the front.

To begin multiple 
transfers, just Attach or 
Save Attachments multiple 
times. Multiple file transfer 
windows show the status 
of each transfer.

Resuming File Transfers
Another feature of FirstClass is the ability to resume a file transfer if it has been interrupted. This can be 
extremely useful if a file transfer is taking place over a modem where long-distance charges apply.

Related Topics:
Resuming an Upload
Resuming a Download



Resuming an Upload
To resume an upload, open the message that you were attaching a file to:

When the 
uploaded file is 
incomplete, a 
special icon 
appears next to 
the file name to 
indicate the 
incomplete 
attachment.

Click on the attachment that is incomplete and choose Attach File... from the File menu. When the file 
dialog appears, select the original file that was being uploaded. The file transfer will then resume from 
where it had left off.



Resuming a Download
If you were downloading an attachment and the link broke off for some reason, you can resume the 
interrupted download later. Open the message with the attachment, choose Save Attachment from the 
File menu, and select the exact folder and file name where the incomplete file is located.

When you click the Download button, FirstClass prompts you to either replace the original file or cancel 
the file transfer. Click Replace, and the file transfer will resume from where it had left off.



Deleting Attachments
Occasionally you will want to delete an attachment from the message that you have just written. This is 
especially true if you have many attachments and you just want to delete a specific one. Fortunately, this 
is extremely easy in FirstClass.

To delete an attachment, click on the attachment in the Attachments list and press the delete key. The 
attachment name disappears from the list, indicating that it has now been deleted.
Deleting attachments can only be done on messages that are unsent. If the message has already been 
sent, it cannot be changed.



Private Chatting
The Private Chat feature allows you to initiate conversations with selected users and quickly exchange 
messages. Messages can be instantly transmitted to the other users involved in the chat session by just 
typing on the keyboard and pressing the enter key.

To open a private chat session, choose Private Chat from the Service menu. A chat window appears:

Initially, you are the only person in the chat. To include others you must invite them into your private chat 
session. To invite others, click the Invite button. A pop-up appears with a list of names of users who are 
currently logged into the system. Since only logged-in users can participate in a chat session, you must 
select from this list.

You can selectively invite people to the 
chat by shift-clicking on the users' 
names, then clicking on the pop-up's 
close box. The selected users are 
invited to your private chat session 
and can accept or decline the 
invitation. If they accept, a message 
announces their entrance into the 
chat.

Note that the italicized names have the Privacy preference turned on and cannot be invited to chat. For 
more information on the privacy option, refer to the Preferences section in Personal Configuration.

To send an instant message to the other chat participants, type your message in the chat box and press 
enter. Messages from the other users will appear in the lower portion of the window. As the chat 
progresses, you can use the scroll bars on the right side of the window to review a log of the session. An 
up-to-date list is also kept of the participants in the chat session. When somebody leaves the chat, their 
name is automatically removed from the participants list.

The Sounds check-box turns on and off the sounds associated with chat. The Scroll check-box prevents 
the lower message area from scrolling, so that you can read the messages at the top of the screen 
without interruption. The rest of the chat will continue to be recorded and you can scroll down at any time 
to see the new messages. In addition, you may select text from the chat and copy it to the clipboard to 
save a transcript of the chat session as a text file on disk.

To exit the chat session, click on the close box of the chat window.



Public Chatting
Another type of chatting is Public Chatting. A public chat can be set up by the Administrator of your 
system and will usually pertain to a specific topic. Public chats appear in conferences and have an icon 
associated with them:

The "active chat" balloon shows that there are other users 
currently engaged in chatting. You can enter the chat by 
simply double-clicking on the chat icon.

Public chatting has all the same functionality as private chatting. You can still invite other users to chat 
and an up-to-date participants list is kept.

To exit the chat session, simply click on the close box.



Multiple Chats
Since FirstClass uses multiple windows, it is possible to have several chat sessions active at the same 
time. Clicking in the appropriate window re-activates that chat session. A typical scenario might have a 
discussion taking place with everybody involved, and several private chats where you communicate with 
individuals:

In this example, several people are involved in the main chat but Dallas Kachan and Peter Smith have 
their own private chat going on in the background.
Also, just like in a regular message, you can double-click on names in the participants list to see the 
résumé of that person.



Invitation to Chat
In both private and public chats, users may invite other users to chat. If you are invited, the following 
dialog appears:

If you wish to join the chat, click the Accept button. You enter into the discussion and your name appears 
in the Participants list. If you do not wish to participate, click the Decline button and the window will 
disappear. The user who invited you will not be notified that you have declined their invitation.
You can automatically decline invitations by setting the Privacy option. This is useful if you are already 
involved in another chat or you are busy and do not want to be interrupted.

To set the privacy 
option, choose 
Preferences... from 
the Edit menu and 
check the box that 
says "Don't accept 
invitations" under 
your chat 
preferences. Once this is set, you will no longer receive invitations.

Searching in Conferences and Folders
Within FirstClass, it is easy to find any item using the built-in Search feature. You can quickly search 
conferences and folders and retrieve relevant messages easily. Like many FirstClass features, finding 
takes place in the background and can be canceled at any time.

To find an item, open up the conference or folder you wish to search and choose Search... from the File 
menu. In the search form, enter the text that you want to find in the "Search for:" box and click the 
Search... button.

In the above example, the system is searching for "VisiSnap" in the subject, attachment name, and 
content of the messages. Any messages in sub-conferences and sub-folders are also searched. For a 
more detailed explanation of the various search options and how to use them, see the Selective 
Searching section later in this chapter.
When you click the Search... button, FirstClass starts searching for the text that you have entered. 

When the system finds any items containing the text that you are searching for, those items are listed in 
the search summary window:

You can open one of the items by double-clicking on it. Note that you don't have to wait for the search to 
finish before you open items; you can open items as soon as they appear in the search summary window.
Once all matching items have been found, you will hear a beep. You can cancel a find at any time by 
closing the search summary window.
While the search is taking place, the name of the conference that is currently being searched is displayed 
in the top right corner of the search summary window. In the above example, the search is being 
conducted in the "Modems" conference for the word "VisiSnap".



You can also click the Search button on the palette instead 
of using the menu.

Searching For Text in Messages
You can also use the Search feature to find selected text patterns within open messages. To do this, open 
up the message and choose Search... from the File menu. The Search dialog appears:

Clicking the Search button scrolls the message down to where the text pattern is located and highlights it.

You can scroll through any other occurrences of the pattern 
using the Search Next feature. To use this, choose Search 
Next from the File menu or use the palette button.

Selective Searching
A find always searches through all of the items in the current window, whether the window is a message, 
folder, or a conference. There are several ways you can further control the search feature:

Search subject/file name: Checking this box expands the search to include the subject of the message.

Search sub conferences & folders: If you check this box on the Search Form, the server will also 
search all of the items in the sub-conferences and sub-folders of the current window, and all of their sub-
conferences. Searching sub-conferences can take somewhat longer than searching just one conference.

Search content of documents: If you want to find some text that occurs in the body of a message; open 
the conference, folder, or mailbox; choose Search...; fill in the text that you want to search for; then check 
the Search Content box. When you click the Search... button, the server will search the full content of 
messages for the text.

Search attachment names: Just like the subject field, you can search for text in the Attachments: list of a 
message. This is particularly useful when you have seen a file that you want, but have forgotten where it 
is. For example, suppose that you remember seeing a copy of Compact Pro™, but you forget what 
conference it was in. Just open up Conferences, choose Search..., and check the Search attachment 
names box.

To search for all messages with attachments, click on the Search attachment names box and leave the 
pattern blank. 

Search "From" name: You may also limit your search to the "From:" field in message envelopes. For 
example, suppose that you want to find every message in your mailbox that was sent by a particular user 
such as "Thor Henrikson". Go into your mailbox, choose Search..., check the Search "From" name box, 
and fill in the pattern.

Search "To/CC" names: You can use this check-box to find all messages that have been sent or copied 
to a particular user.

The Search feature in FirstClass is very powerful, however, if you are logged into a large system it is a 
good idea to restrict the search as much as possible. Searching through the content of messages and 
recursively searching through conferences can be very time-consuming.



Searching External Folders and Drives
FirstClass provides very easy-to-use links to external folders and hard drives. This means that CD-ROMs 
and hard disks can easily be connected into FirstClass. Searching will work on these external folders just 
as it does within the rest of FirstClass.

To search an external folder, open the folder from FirstClass and choose Search... from the File menu. 
The search form is displayed:

With external folders, only the check boxes on the left-hand side will have an effect on the find. Attempting 
to search on attachments, "From" names, or "To/CC" names will have no effect on the find.
The following check-box items take on the following meanings when searching external folders:
Search subject/file name: Check this if you wish to search file names for the pattern.
Search sub-conferences & folders: Check this to search sub-folders for the pattern.
Search content of documents: Check this box to have the Search open each file of type TEXT and 
search the content for the requested pattern.

Click the Search... button and a search summary of matching items is displayed. Since the items being 
matched are files, a standard file dialog will appear asking you where to download the file.

For a more comprehensive overview of external folders, see the section entitled External Folders and 
Disk Files.



Preferences
FirstClass allows you to set preferences on how you view messages and lets you set options on chatting. 
To set these preferences, choose Preferences... from the Edit menu. The following window appears:

Show items in conferences in reverse order: Messages in conferences are listed with the 
oldest at the top and the newest towards the bottom. Selecting this preference 
reverses the order and puts newer items at the top of message listings. This 
preference is automatically set for all users.

Show only unread items in conferences and mailbox: Only items with unread flags are shown 
in conferences and your mailbox. Checking this preference makes message lists 
much shorter since you only view items that you have not previously read.

Don't accept invitations: This turns on the Privacy preference and prevents other users from 
inviting you to chat. If this preference is set, your name is italicized in directory 
listings.

Sounds during chat and invite: Setting this preference turns on sounds during chats.



Changing your Password
To change your password, choose Password... from the Service menu. Type in your old password, type in 
your new password, then re-type your new password to verify it.

When selecting a password, 
try to mix numbers, letters, 
and other characters. This 
makes it much harder for 
somebody to correctly guess 
your password.

Click OK to save your new password. The next time you login you will have to use the new password.



Session Status
To check how long you have been connected and how much time is remaining, choose Session Status 
from the Window menu.

The Session Status also 
displays the name of the 
system you are currently 
connected to.

Creating and Editing your Résumé
Each user (and conference) has a custom résumé. A résumé contains information about yourself for 
others to see. To edit your résumé, choose Résumé from the Edit menu. When you type in the new 
résumé and close the window, the new résumé is saved on the server and will be displayed for other 
people upon request.

You can edit your résumé just like a regular message: move your cursor into the window, click, and begin 
typing.



Personal Privileges
Each user in FirstClass has a set of privileges that can be assigned or restricted by the Administrator. The 
following is a list of the privileges that can be assigned to any user or group of users:

Sending and receiving private mail.
Access to public conferences.
Chatting with other users.
Searching.
Uploading files or attachments.
Downloading files or attachments.
Viewing résumés.
Viewing of unlisted users.
Command line access.
Graphical interface access.
Creating conferences.

Depending on the system you are on, you may have all of these privileges or you may only have a limited 
set.



Double-Clicking
In Macintosh and Windows environments, double-clicking is used as a short-cut to open files and folders. 
This is also used in FirstClass; double-clicking on icons, message items, or conferences will open them. 
Additionally, FirstClass supports double-clicking on the following items:

Names in messages Double-clicking on any name in the To:, From:, or Cc: field of a message 
displays the résumé of the person. In the case of a conference, the 
conference info will be displayed instead.

Names in Directory list Double-clicking on any name in the directory list displays the résumé of the 
person. If the name is a conference or gateway, then conference or gateway 
information is displayed.

Names in Chat Double-clicking on any name in the Participants list displays the résumé of 
the person.

Names in History Double-clicking on any line in the History list displays the résumé of the 
person or, in the case of a gateway, information on routing to that gateway.

Attachments: field Double-clicking on any attachment initiates a download dialog and saves the 
attachment.

Editable text Double-clicking on any text while in the editor will select the entire word.



Who's Online
You can determine who is online at any time by choosing Who's Online from the Service menu.

The Who's Online listing 
also shows you who has the 
Privacy preference turned 
on. Users with italicized 
names cannot be invited to 
chat since the Privacy 
preference is turned on.

You can also determine who is online if you are doing an ordinary directory listing. Any names that are 
bolded in a directory listing are users who are currently logged into the FirstClass system.



Directory searches
When you address a message by typing names in the To: or Cc: fields, FirstClass matches those names 
against entries in the directory. Every address name must match a directory entry in some way, even if 
that match is an indirect one (a gateway name, for example, in the case of a user on another system).

If more than one name is found, FirstClass displays the names that match and allows you to select the 
names you want (by clicking to select one, or shift-clicking to select multiple names). The following icons 
are used to provide information on each directory entry:

A Network user, connected to the FirstClass server through 
a network.

A Telecom user, connected to the FirstClass server through 
a modem.

A conference on the FirstClass server.

A gateway connecting the server to another system.

A distribution list containing the names of users and/or 
conferences associated with a certain topic. This list is 
created by the Administrator for easy addressing.

Any names that are bolded in a directory listing are users who are currently logged into the FirstClass 
system.

You can address a message using a name associated with any of the above icons. A gateway name is 
only part of the address, however; see Using Gateways for more information on addressing messages to 
users on other systems.



External Folders and Disk Files
Depending on the FirstClass system you are connected to, you may have access to external folders (or 
directories) on hard disks or CD-ROM players. Accessing these files and folders is similar to accessing 
messages and conferences in FirstClass. Folders are located in the upper panel and files are located in 
the lower panel:

If you need to access a file on the disk, just double-click on the file in the message list and a standard file 
dialog will appear, allowing you to download the file.



Get Info: Viewing/Changing File Information
All messages and files on FirstClass have some additional information which you can look at by selecting 
the item and choosing Get Info... from the File menu:

This information includes:

Icon FirstClass allows you to pick the icon for any message that you have permission to change. 
This is normally used for selecting conference and folder icons, but it can also be used on 
messages and files.

Name The file name or, in the case of a message or conference item, the sender or recipient of the 
message.

Subject The subject of the file or message. You can change this description by editing the field.

Kind FirstClass items are classified according to their contents. If the item is a Message, 
Conference Item, or Text then it can be viewed on FirstClass. Other items, which cannot be 
viewed, are of type File. They can be uploaded, downloaded, or attached to other messages.

Size Size of the file, in kilobytes.

Where The "path" where the file or message is located within FirstClass.

Created The date and time that the item was created.

Modified The date and time that the item was last modified.

Expires The date and time that the item will be automatically deleted. If you wish to retain a particular 
item, click on the Expires date and the expiry date will be canceled.

Expires in    The number of days that the item will be retained before automatically being deleted.

Unsent Indicates whether an item has been sent or not.

Protected    Indicates whether an item has special protection against deletion or changes.

Unread Indicates whether an item has been opened or not.

Auto Open    Indicates whether an item will automatically open at logon time or not.

OK Click this button to save any changes you have made.

Cancel Click this button to exit without saving any changes.



Expiry Dates and Automatic Deletion
All messages and files on FirstClass are assigned an expiry date when they are created. This date is set 
by the Administrator and is usually something like 60 days from the date of creation. To view the expiry 
date of any message, select the message and choose Get Info... from the File menu. Look for the expiry 
date at the bottom of the Get Info form.

The file is automatically deleted by the system when it reaches the expiry date. Expiry dates are 
necessary because they keep mailboxes and conferences tidy and remove old messages that otherwise 
could fill up the server's hard disk.

However, if you wish to save a message permanently and not have the system delete it, you can use Get 
Info to set the expiry date. Click on the    Expires In field and adjust the number of days to expiry:

Once the expiry date is reached, the message will automatically be deleted.



Organizing Windows
One of FirstClass's big advantages over conventional electronic mail and conferencing systems lies in its 
use of multiple windows. Using windows in FirstClass allows you to cut and paste information between 
different messages, upload and download files in the background, and conduct chats in other windows. To 
help organize windows, FirstClass provides two ways to re-organize: Tiling and Cascading.

When your window becomes cluttered, choose Tile from the Window menu. Each window that you have 
open is re-sized and displayed on the screen:

Similarly, if you choose Cascade from the Window menu, the windows are stacked so that all the title bars 
are visible.

The advantage in cascading over tiling is that cascading takes up less room on your screen. Tiling 
windows uses up every available portion of the screen to display all the windows.
To cycle between windows, choose the Next Window command from the View menu. This cycles through 
each and every FirstClass window, making it active.



About Modems
Modems allow two computers to communicate over a telephone line. If you are using a modem to 
communicate with a FirstClass server, it is helpful to understand the following:

The standards used by different modems and their manufacturers.

How to install, connect, and configure modems.

Troubleshooting modems.

FirstClass has been developed to minimize the amount of interaction you have with your modem. 
However, we do recommend that you familiarize yourself with your modem by reading the User Manual 
that was packaged with the modem.



Modem Standards
One of the problems when you are dealing with modems is that you have to learn a whole new language 
in order to understand what is going on. Most modem features are referred to by a code that is assigned 
by the Consultative Committee for International Telephony and Telegraphy (CCITT). The standards 
described here fall into one of two categories: error correction and data compression.

Error Correction is a method of correcting errors that occur between two modems as a result of outside 
interference, such as noise on the phone line. This ensures that the data that comes out of the receiving 
modem is exactly the same as the data that goes into the sending modem. Note that this only corrects 
errors that occur between the two modems¾it cannot correct errors that occur between the modem and 
the computer.

Data compression is a method of compressing the data at the sending modem, sending it across the 
modem link, and then expanding it at the receiving modem. This will result in an increase in the effective 
through-put, if and only if the data can be compressed. If the data cannot be compressed (for example, if 
it has already been compressed with a utility such as PKZip), then modems with data compression will 
have no benefit.

Here are some of the abbreviations that you should understand:

Baud Rate or Bits Per Second The measure of how fast a modem is. The standard baud rates are 300, 
1200, 2400, 9600, and 14400. The faster the baud rate, the better. If you divide the baud rate by 
10, you get a rough estimate of the number of bytes (or characters) per second, and this in turn 
gives you an idea of how long a file transfer will take. For example, a 2400 baud modem can 
transfer about 240 bytes per second; which works out to about 4 seconds per thousand 
characters (1K). Therefore, a 25K file would take roughly 25 x 4, or 100 seconds to transfer. 
Obviously, faster speeds are better.

V.32 The CCITT standard used for modems to communicate at speeds of up to 9600 baud.

V.32bis The CCITT standard for modems to communicate at speeds of up to 14,400 baud.

V.42 The CCITT error correction standard.

V.42bis The CCITT data compression standard. It has a theoretical compression ratio of 4 to 1.

MNP Error Control The Microcom Networking Protocol. An early error correcting protocol.

MNP Level 5 Compression The Microcom data compression standard. This is not as good as the 
V.42 standard, because the maximum compression is only 2 to 1. Furthermore, if you try and 
send a file which has already been compressed, MNP 5 will actually slow down the transfer.

Fall Back When two modems initially connect, they negotiate in order to find the best connection 
that they can make. Often this is not the best connection that one of the modems could make; in 
this case, you would say the modem has fallen back to the lower rate. For example, if a 2400 
baud and a 9600 baud modem try and connect with each other, they should negotiate a 2400 
baud connection. The 9600 baud modem would then fall back to 2400 baud.



Installing Modems
You will need a 1200 baud (or better) Hayes-compatible modem to connect to FirstClass. If you are using 
an external modem, connect the modem to a serial port on your computer, using an appropriate cable:

For exact details on installing a modem and connecting it to your computer, you should consult the 
manual supplied by the modem manufacturer.

If your modem is a high-speed modem, ensure that you are using a cable with hardware handshaking 
capability. See the Flow Control and Hardware Handshaking section later in this chapter.



Modem Setup
Connect to a FirstClass system using a modem is typically a matter of setting a few parameters, saving 
them, and then logging in. To set these parameters, choose Service Setup from the Service Menu. Select 
"modem.fcp" in the Connect File field, fill in rest of the form as appropriate, then click Save. Choose 
Connection Setup from the Service menu, and select Modem from the sub-menu. The Connect File Setup 
dialog appears:

Each of these parameters is briefly described below. Some of the settings are described more fully later in 
this chapter:

Protocol Indicate the type of connection to the FirstClass server by choosing Serial (for a 
modem) or IPX (for a network connection).

Debug Checking this box causes a debug screen to appear for the session.

Modem Script This popup lists all the various types of modems that FirstClass has provided 
initialization strings for. Select the type that is most suitable for your modem.

Port The port on your computer which is connected to the modem.

Phone Line If your telephone line supports tone dialing select Tone, otherwise select Pulse.

Baud Rate Speed of modem being used. Set this to the highest speed that your modem 
supports.

Volume The setting for the modem speaker. The most commonly-used volume settings are 
ATM0, which turns the speaker off, and ATM1, which enables the speaker until carrier 
is received.

H/W Handshake Select the signal used for hardware handshaking. See the Flow Control and 
Hardware Handshaking section later in this chapter for more details.

DTR Hangup Selecting On will have FirstClass signal the DTR pin to hang up the modem.

Auto Speed If your modem will automatically adjust the speed when a connection is made, then 
select On.

Carrier Detect Select On to enable carrier detection, which enables the modem to determine that 
there is still a connection.

Cancel Cancels any changes that you made and brings you back to the Login screen.

Save Saves any changes you have made and brings you back to the Login screen.



Modem Trouble Shooting
Here is a list of some of the common problems you may encounter, along with suggested fixes:

"There is no response from the modem": This means that FirstClass did not receive an "OK" message 
in response to the reset command.

There are several possible causes of this error:

1. The wrong type of modem has been selected from the list of possible modems. Try "Enhanced 
Hayes Compatible" if problems persist, and if that doesn't work try "Basic AT Commands". If this 
does not fix the problem, then you will have to edit the strings to make them work with your 
modem.

2. There is a command in the reset string that the modem does not support. Use a text editor to look 
at the modem file you are using (under the SCRIPTS directory, choose the appropriate file with 
an MDM extension) to check the attention string for the modem against the modem's manual.

3. The modem is not turned on.

4. The modem has crashed or gone into a "funny" state (this is more common than modem 
manufacturers would have us believe!). The only solution to this is to turn the modem off and 
back on.

5. The modem cannot communicate at the speed you have selected. Try 1200 or 2400 baud.

6. The cable connecting the modem to the computer is loose or defective.

7. Hardware Handshaking has been selected but a Hardware Handshaking cable is not installed.

8. There is no modem connected to the port that has been selected.

You can hear the modems negotiate but then get "There is no response from the server modem" 
error: This generally means that there is an incompatibility between the modems at the server and client 
ends. Again, this is more common than modem manufacturers claim. It is especially common on modems 
that offer high speeds or advanced protocols. Try these solutions:

1. The modem at the other end might not be connected to a FirstClass system. Check the phone 
number.

2. Connect at 2400 or 1200 baud as a test. Almost all modems will work at these speeds.

3. Try again. The problem might have been caused by a poor telephone line. This is common on 
long distance connections.

4. The wrong type of modem has been selected from the list of possible modems. Try "Enhanced 
Hayes" if problems persist, and if that doesn't work try "Basic AT Command Set". If this does not 
fix the problem, then you will have to edit the strings to make them work with your modem.

5. The value of the connect timeout register (S7) was too short. Refer to the modem manual and 
use a text editor to look at the modem file you are using (under the SCRIPTS directory, choose 
the appropriate file with an MDM extension) to change the modem strings to increase this value 
(S7=60).

You can hear the modems negotiate but then get "Host does not appear to be a FirstClass Server" 
error: This means that a modem answered the call and the two modems negotiated, but the system at 
the other end did not respond to the FirstClass User Interface.

1. The modem at the other end might not be connected to a FirstClass system. Check the phone 
number.

You get communication failures while accessing the FirstClass server: A communication failure 
while a call is in progress means that the modem connection has failed for some unknown reason. This 



type of problem can be very difficult to track down.

Try these suggestions:

1. Try again. The problem might have been caused by a poor telephone line. This is common on 
long distance connections.

2. A background application is using up all available CPU (e.g., screen savers, graphics 
applications, file compressors). Remove or quit the application, and try again.

4. If you have a high-speed modem and are also connected to a network, the network packets may 
be interfering with the serial port. Disable the network connection and try again.

5. You may have set the baud rate too high in the FirstClass Client application. Try lowering the 
speed and trying again.

A good test is to try calling out from your modem to some other modem using a terminal emulation 
package. If you have problems connecting then you might need to make some changes to your modem's 
configuration. See your modem manual for details.



Flow Control and Hardware Handshaking
If you use a modem with any form of error correction or compression, you will have to enable hardware 
flow control. Flow control is the method that the modem uses to control how much data is sent from the 
computer to the modem.

There are two methods of flow control available: XON/XOFF and RTS/CTS. XON/XOFF flow control uses 
two special characters; XON to tell the computer to start sending data, and XOFF to tell the computer to 
stop sending data. XON/XOFF flow control cannot be used with a binary protocol such as the one used 
by FirstClass. You must ensure that any modem setup strings you create do not turn on XON/XOFF flow 
control.

The second method of flow control uses hardware pins on the modem and the computer, the RTS 
(Request To Send) pin and the CTS (Clear To Send) pin. To make the connection you require a cable that 
has pins 4 and 5 equipped at both ends.



The File Menu
The File menu provides several file 
management features, each of which 
is summarized below:

New Settings Create a new settings file for connection to a FirstClass server.

Open If you are not connected to a FirstClass server, use this to open 
a settings file. If you are connected, use this to open any items 
you have selected.

Save Save the contents of the current window to a text file on your 
computer.

Attach File... Attach a document or file to the currently active message.

Save Attachment... Transfer the document or file from a message to your computer.

Delete Delete the current message, alias, or any selected items.

Get Info... Display file information for the current message or item.

Search... Find a selected pattern inside messages. The Search can be 
expanded to search sub-conferences and content of messages, 
text, or files.

Search Next Find the previously-entered pattern again.

Exit Logoff from FirstClass and terminate the FirstClass application.



The Edit Menu
The Edit menu allows you to cut and 
paste text between messages and 
also to change things such as your 
password and user preferences. All 
font and styling changes can be made 
through this Edit menu.

Undo Retrieve text that has been deleted during an editing session.

Cut Cut (delete) selected text and place it on the clipboard.

Copy Copy selected text onto the clipboard.

Paste Insert the contents of the clipboard into the current message at 
the current cursor position, replacing any selected text.

Clear Erase selected text.

Select All Select all text in the current window. This can also be used to 
select all messages, icons in a list, or names in a directory 
listing.

Preferences... Set user preferences for chatting and reading messages.

Résumé... Display/edit your personal résumé. This also displays the 
résumé of any selected user in a directory window.



The Message Menu
The Message menu shown here 
contains commands for creating, 
sending, replying to and forwarding 
mail. Each command is summarized 
below.

New Message Create a new message in your mailbox, folder, or conference.

New Form Create a form, selected from the sub-menu, in your mailbox to 
edit and send.

Reply Reply to the current or selected message. A new message is 
created and automatically addressed to the sender with a copy 
to each person in the original To: and Cc: lists.

Forward Forward the current or selected message to another user. A new 
message is created with the same content as the original.

Send Send the current message, or any messages that are selected. 
The message is delivered to each recipient in the To: and Cc: 
lists.

History Display the history of a message.



The Conference Menu
The Conference menu contains 
commands which are relevant to 
conferences.

Open Unread Open the next unread item in the current window.

Next in Thread Open the next message in the current thread. Hold down the Ctrl 
key to open the previous message in the thread.

New Conference Create new conferences (only available if you have the proper 
permissions).

New Folder Create a new folder on your desktop, in your mailbox, in another 
folder created previously, or in a conference if you have 
appropriate permissions.

Make Alias Place the conference icon on your desktop as a short-cut to the 
conference. The unread flag indicates any new items appearing 
in the conference.

Approve Approve any unapproved messages (if you have approval 
privileges for this conference).

About Conference Display a description of the conference contents.



The View Menu
Use the View menu to change the 
way FirstClass displays information. 
You can view files by icon or by name 
and you can organize your windows 
on the screen.

By Icon Display the items in the current window in iconic format.

By .... Display the current window sorted by Date/Name/Subject/Size.

Reverse Sort Display the items in the selected window in reverse sort order.



The Window Menu
Use the Window menu to change the 
way FirstClass displays windows. You 
can also display your session status or 
display the palette.

Tile Arrange all open windows into a tiled pattern on the screen so that all 
windows are visible and no two windows overlap.

Cascade Arrange all open windows into an overlapped, cascading pattern so that 
the title of each window can be seen clearly.

Arrange Icons Tidy the icons for minimized windows at the bottom of your screen. This 
command does not apply to icons within FirstClass, such as those on 
your desktop or in a folder.

Close All Close all open windows.

Session Status Display or hide the session status.

Palette Display or hide the palette.

There will be other items on the bottom of the view menu. These correspond to the windows that you 
currently have open. Each of these corresponds to a command key so that you can easily jump to any 
window.



The Service Menu
Use the Service menu to set up your 
FirstClass connections. You can also 
look up and communicate with other 
users.

Connect/Disconnect Reconnect to FirstClass if you were disconnected, or logoff from 
FirstClass but keep the application open (leaving all windows 
open as well).

Connection Setup Set the connection protocol and modem parameters, if 
appropriate, by choosing the appropriate setup file (IPX or 
modem) and filling in the settings.

Service Setup Provide connection parameters for logging in to a FirstClass 
server.

Directory Search the user directory for specific names.

Who's Online Display a window telling you who is currently logged into the 
system.

Private Chat Create a private chat session. Within the chat session, you can 
invite other users to participate.

Password... Change your login password.



The Message Palette
In order to help you navigate while reading messages, FirstClass provides all the messaging commands 
in a palette for easy access. To open the palette, choose Palette from the Window menu. The palette 
floats above all other windows in FirstClass, so you can open messages and use the buttons on the 
palette to move around.

New message

Forward current message

Attach file to message

Search

Directory

Previous unread message

Previous message in 
current thread

Previous message

Send message

Reply to message

History of message

Search again

Delete message

Next unread message

Next message in current 
thread

Next message

Installing FirstClass Notify
The Network Notification Utility is easily installed, along with the FirstClass Client application, on any 
computer running FirstClass. It allows network users to be notified of new incoming mail without running 
the FirstClass Client application. Note that the Network Notification Utility can only be used over IPX-
compatible networks. Installing it when you connect over modems will have no effect.

Installing the Network Notification Utility is done at the same time the FirstClass Client application is 
installed, as an option. If you didn't install the utility when you installed FirstClass, you can install it by 
copying the "fcnotify.exe" and "fcnotify.ini" files to the FirstClass directory that you designated when you 
installed FirstClass (for example, "fcwin"). Use the Program Manager to create an FCNotify program item 
for "fcnotify.exe".

You can configure the utility to run automatically when you enter Windows, by dragging the FCNotify 
program item into the Startup program group. Or, if you wish, you can run the Network Notification Utility 
as a normal application by double-clicking on the FCNotify program item.

In order to set up the Network Notification Utility or check to see if you have mail, double-click on the icon 
for the FCNotify program item. The following dialog appears.

To set up the Network Notification Utility, click on the Setup menu item. The Setup dialog appears.



Enter your UserID and Password. You can also specify how you want to be notified of new messages; 
using sounds or a pop-up menu. When you receive new messages, you will be immediately notified in the 
method you have chosen.

In addition, every time you start your computer, the notification utility will check with the server to see if 
you have any new messages. If you do then you are immediately notified.



Settings Documents
Once you have successfully configured FirstClass and logged in, it is convenient to save those settings 
for future use. You can do this by creating a settings document. For each separate FirstClass system that 
you log in to, you can create a customized settings document:

Once a settings document is created, you need only double-click on the document and the FirstClass 
application will be automatically configured to log in over modem or network, select the proper modem 
type, and dial the correct telephone number. This feature is especially useful if there are many different 
systems that you constantly use.
We recommend that all settings documents be located in one place. In the FirstClass Client directory, we 
have already created a directory called SETTINGS which contains settings documents for SoftArc Online, 
our own FirstClass customer support system and others.
Depending on the system you are logging into, the Administrator may have already customized a settings 
document. This customized document can contain individual sounds, icons, and login screens that are 
specifically for that system. Make sure to check with the Administrator to see whether there is a 
customized settings document. Settings documents are very important. These documents contain 
individualized icons and sounds for specific systems.

To create a settings document, choose Service Setup from the Service menu. Next, choose the 
appropriate connection method from the Connect File popup and configure all the parameters. It does not 
matter whether you connect via modems or AppleTalk, the settings documents can be used for both.

Once you have correctly entered all the parameters, click the Save button to save these settings. A 
standard file dialog will appear asking you where to put the settings document. If you are changing an 
existing settings document, then you can click the Save button to save the new settings.



Hot Keys
The following is a list of Control Keys used in FirstClass:

Ctrl + / Open the next item in thread.
Ctrl + A Select all items/text.
Ctrl + C Copy selected text onto the clipboard.
Ctrl + D Delete selected items.
Ctrl + E Send the current message.
Ctrl + F Find specified text.
Ctrl + G Find the next instance of the specified text.
Ctrl + L Search the system directory.
Ctrl + N Create a new message in your mailbox.
Ctrl + O Open any items you have selected.
Ctrl + R Reply to a message.
Ctrl + T Attach a file to a message.
Ctrl + U Open the next unread item.
Ctrl + V Insert the contents of the clipboard after the cursor.
Ctrl + X Delete selected text and copy it to the clipboard.

The following is a list of Alt keys used in FirstClass.

Alt+ Enter Get information about messages and files.
Alt + F4 Exit the FirstClass application.
Alt + H Display the history of the current message.
Alt + M View by date.
Alt + Y View by icon.



Auto-Registration
If you do not have a User ID and Password, you may still be able to access the FirstClass server by 
registering yourself. This will only be possible if the Administrator of the server has enabled this feature. 
To auto-register, run the FirstClass client as usual entering the User ID that you wish to have. Click on the 
Login button, then after connecting to the server the following dialog box will appear:

Once you have filled in the form, make sure all the information is correct and click on the Register button. 
The next dialog appearing will display your assigned User ID and Password. Write your User ID and 
Password down for future use and click OK. You will now be logged in and your desktop will appear.



General Errors
1001 Your version of FirstClass software is incompatible with the server. Please obtain an updated 

version.
What to do: Obtain a new copy of the FirstClass Client software. This would only happen if you 
have a very old version of the software.

1002 Your request cannot be completed because there is no memory available on the server. Please 
close some of your windows and try again.
What to do:  Close some of the windows that you have open. If you are editing large messages, 
the server must keep them in memory. This often means that only your session has run out of 
memory, not the entire server.

1003 There is no such user registered on FirstClass.
What to do: Check your settings and try again. Either the UserID or password is wrong.

1005 That object no longer exists.
What to do: Reopen the message and try again. This is caused when you try to forward or reply 
to a message after the conference containing the message has been closed.

1006 Sorry. That document is damaged and cannot be accessed.
What to do: Delete the offending document.

1007 Sorry. That document is damaged and cannot be accessed.
What to do: Notify the Administrator.

1008 That object is read-only.
What to do: Do not try to change or delete a read-only document such as an item in an external 
folder or a help document.

1009 Your changes could not be saved.
What to do: Try saving again.

1010 You are not logged in to the FirstClass Server. Please choose Connect in the File Menu and log 
in.
What to do: Connect to the FirstClass server if you want to open or edit a window.

1011 That feature is not yet implemented. Check that you have the latest version of the FirstClass 
software.
What to do: Either run an older version of FirstClass Client software when connecting to that 
server or talk to the Administrator about upgrading the server.

1012 The communication link has failed and is unable to transmit your requests to the server. Please 
Quit and log in again.
What to do: Quit and log back on again.

1013 You are already logged in.
What to do: Wait a few moments and try again. This usually occurs after a communication link 
failure, because the server has not yet detected the failure of the link.

1014 You cannot perform that function on the selected object(s).
What to do: Report this error to SoftArc (it should never occur).

1015 Your request cannot be completed because you do not have any objects open.
What to do: Open an item before trying to perform the function.

1016 An error has occurred on the FirstClass Server. Please contact your Administrator and report the 
problem.
What to do: Delete the offending document (if possible) or contact the Administrator.



1017 That feature is not yet implemented. Check that you have the latest version of the FirstClass 
software.
What to do: Either run an older version of FirstClass Client software when connecting to that 
server or talk to the Administrator about upgrading the server.

1018 Your request cannot be completed because you have reached a server limit.
What to do: Contact your Administrator.

1019 An error has occurred on the FirstClass Server. Please contact your Administrator and report the 
problem.
What to do: Report this error to SoftArc (it should never occur).

1020 An error has occurred on the FirstClass Server. Please contact your Administrator and report the 
problem.
What to do: Delete the offending document (if possible) or contact the Administrator.

1021 You cannot access that object because someone else already has exclusive access to it.
What to do: Wait a while before trying to access the file. (Someone else has the file open for 
write access.)

1024 Your message cannot be delivered at this time because the server is busy. Please try again later.
What to do: Wait a little while and try to send the message again later.

1026 That message has already been sent. To resend it use the Forward command.
What to do: If you have permission to "Edit sent mail" you may edit the sent message. 
Otherwise, you must forward the message to send it again.

1027 The communication link has failed and is unable to transmit your requests to the server. Please 
Quit and log in again.
What to do: Check your modem setup. The failure may either be caused by catastrophic link 
failure (no data gets through) or repeated errors.

1028 The person's name contains invalid characters.
What to do: Use only numbers and letters in a user's name.

1029 Sorry. Only the Administrator can perform that function.
What to do: Avoid using functions that you do not have permission to perform.

1030 Sorry. You are not permitted to perform that function.
What to do: Avoid using functions that you do not have permission to perform.

1031 That UserID is already registered. Please choose an alternate UserID.
What to do: Enter a different UserID. (UserIDs must be unique on a system.)

1032 You can only subscribe to Conferences. That object is not a Conference.
What to do: Select a conference before trying to make an alias.

1033 That name is already taken. Please choose a different name.
What to do: Choose a different name. (Names must be unique.)

1034 There is no response from the modem. Check that your modem is switched on and connected to 
the telephone line. Also, check the modem type, hardware handshake settings and cable, and 
auto speed setting.
What to do: Follow the instructions in the error message, or make sure that the Hardware 
Handshaking box is not checked if you do not have a modem. See the section on Modems for 
more details.

1035 Invalid user name or password.
What to do: Check your settings and try again. Either the UserID or password is wrong.

1036 Sorry. You can only reply to incoming mail.



What to do: Either select an incoming message before you choose Reply, or do not choose 
Reply when you have composed a message that is still open.

1037 The conference is full. Please delete some items.
What to do: If you have the appropriate permission, delete some old items or drag them into sub-
folders. If you do not have permission for this conference, contact your Administrator.

1038 The User Directory is locked. If problem persists, restart the FirstClass Server.
What to do: Contact your Administrator.

1039 A file system error has occurred on the FirstClass Server. Please report the problem to your 
System Administrator.
What to do: This usually means that you have attempted to open a file which does not exist. If it 
persists, delete the offending item or contact your Administrator.

1040 Sorry. You can only forward messages.
What to do: Do not attempt to forward text documents or items on external folders. Select a 
message before choosing Forward.

1041 Sorry, this message may not be sent until it has been properly addressed.
What to do: Enter at least one valid name in the To: or Cc: field before sending the message.

1042 Sorry, your command could not be completed, the Server has run out of disk space.
What to do: Contact your Administrator. You may be asked to delete old messages.

1043 Sorry, a résumé does not exist for this user.
What to do: Do not request a résumé for the item (not necessarily a user) again, since none 
exists.

1044 Sorry there is no FirstClass Server with that name on the network. Check your connection setup.
What to do: Ensure that the server name and zone in the settings document match the actual 
server name and zone.

1046 Sorry your access privileges do not allow you to log in over the network. You may only log in 
through a modem.
What to do: Log in through a modem or request that your Administrator change your user class 
to Network.

1047 Sorry, cannot add a user with that class.
What to do: Caused by attempting to change the Class to an incompatible type (e.g. trying to 
change the class of a conference to Network User).

1048 File could not be opened because the file has been deleted.
What to do: Avoid any further attempts at working on this file, since it has been deleted.

1049 Your daily time limit has been used up. You must wait until tomorrow before logging in again.
What to do: Wait until tomorrow to log in again. Only the Administrator can change the daily time 
limit assigned to you.

1050 Sorry, the user directory may be inconsistent. Please report this to your Administrator.
What to do: Report the error to your Administrator.

1051 Sorry, that user has already logged off.
What to do: Avoid attempts at contacting the user, or send the user a message instead.

1052 Sorry, that user is running an old user interface.
What to do: Provide the user with information on obtaining the latest version of client software.

1053 Sorry, you cannot logon right now because logons have been disabled. Please try again later.
What to do: Wait a while, then try to log on again. If the problem persists, contact your 
Administrator (if possible).



1054 Modem returned ERROR. Check that you have selected the correct modem type.
What to do: Check your modem setup. See Chapter 10: Modems for details.

1057 Serial port is in use by another application. Check the selected port.
What to do: If another application (such as a terminal program or fax software) has the same 
serial port open, close the application and restart FirstClass. If the problem persists, restart your 
computer.

1058 The selected serial port is not available.
What to do: Either install the serial port card (if the system is configured to use an expander 
card) or restart your computer.

1059 Sorry, that person would prefer not to chat at this time.
What to do: Send a message to the user if you wish to communicate with someone who has the 
privacy preference turned on.

1060 Sorry, there is no conference with that name.
What to do: Try addressing the message again. It is possible that the conference was deleted 
between the time you initially addressed your message and the time you tried to send it.

1061 The modem has dropped the carrier.
What to do: If you have Carrier Detect enabled but your machine, cable, or modem does not 
support carrier detect, these errors will occur randomly. Correct your modem setup (see the 
section on Modems for more details).

1062 End of thread.
What to do: You have reached the end of a particular thread. Select a new message to use 
threading on, if you wish.

1065 Cannot continue transfer.
What to do: Check the results of your transfer. If the file has been transferred successfully, ignore 
the error. If not, try to continue the transfer. If the problem persists, contact your Administrator.

1066 Sorry, that is an incomplete file.
What to do: Request that the message sender upload the file again.

1067 Sorry, you cannot edit a document before it has been completely received.
What to do: Wait for the form to fill completely before clicking in any field.

1070 This object is on a disk that has not been mounted.
What to do: The volume that you are accessing is not currently mounted.    You may want to send 
a message to the administrator notifying then of this occurence.    Also, the volume might be 
temporarily unmounted and might later be available (this is very common if the volume is a CD-
ROM).

1071 You cannot move objects across volumes.
What to do: Use the Copy command to copy an object to a different volume.

1072 FCP configuration error.
What to do: Contact your Administrator.

1073 The server does not have your interface option installed.
What to do: Use a different connection method to login to the server.

1074 Could not access IPX network services. Check that IPXODI has been loaded.
What to do: You have not correctly installed all the drivers necessary to run IPX on your network. 
You may want to contact the administrator of your LAN and make sure your machine is properly 
installed with the correct drivers.

1075 Could not open network socket.
What to do: Check to make sure that the network is still running and that you have installed all 



the correct drivers.

1076 Windows option has not been installed on the server.
What to do: You cannot login to this server with the Windows GUI since that option has not been 
installed.

1077 Message could not be sent because it contains partial attachments.
What to do: Either finish uploading the incomplete attachments or delete those attachments from 
the message.    You will then be allowed to send the message.



Modem Errors
1027 The communication link has failed and is unable to transmit your requests to the server. Please 

Quit and log in again.
What to do: Check your modem setup. The failure may either be caused by catastrophic link 
failure (no data gets through) or repeated errors.

11034 There is no response from the modem. Check that your modem is switched on and connected to 
the telephone line. Also, check the modem type, hardware handshake settings and cable, and 
auto speed setting.
What to do: Follow the instructions in the error message, or make sure that the Hardware 
Handshaking box is not checked if you do not have a modem. See the section on Modems for 
details.

11054 Modem returned ERROR. Check that you have selected the correct modem type.
What to do: Check your modem setup. See the section on Modems for details.

1057 Serial port is in use by another application. Check the selected port.
What to do: If another application (such as a terminal program or fax software) has the same 
serial port open, close the application and restart FirstClass. If the problem persists, restart your 
computer.

1058 The selected serial port is not available.
What to do: Either install the serial port card (if the system is configured to use an expander 
card) or restart your computer.

1061 The modem has dropped the carrier.
What to do: If you have Carrier Detect enabled but your machine, cable, or modem does not 
support carrier detect, these errors will occur randomly. Correct your modem setup (see the 
section on Modems for more details).
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AFP
AppleTalk File Protocol: a network protocol developed by Apple Computer that gives access between file 
servers and clients on an AppleShare network.



America Online
America Online is a large graphical Online system that caters to users of Macintoshes and PC's running 
Windows.



AOCE
Apple Open Collaboration Environment.    An electronic mail specification developed by Apple Computer.



AppleLink
AppleLink is the official Online service operated by Apple Computer. 



AppleTalk
Networking system built into every Macintosh computer.    Also called LocalTalk.



Baud
A measurement of data transmission speed.    Used primarily when discussing modem speeds.



BBS
Bulletin Board System.



bps
Bits per second.



CCITT
Comite Consultatif Internationale Telegraphie et Telephone.    An international standards group 
responsible for creating many computer and communication standards such as X.400 and X.500.



CCITT
Comite Consultatif Internationale Telegraphie et Telephone.    An international standards group 
responsible for creating many computer and communication standards such as X.400 and X.500.



CompuServe
The largest Online service in the world. 



CTS
Clear to Send.



DECnet
A set of networking protocols developed by Digital Equipment Corporation.    DECnet is also compatible 
with Ethernet.



Directory
You can look up users in the FirstClass directory.    Pull down the Service menu and choose Directory.    
You will be prompted for a pattern; if you do not enter one, all user's will be listed.



Ethernet
Network protocol developed by Xerox.



Fall Back
When two modems connect, the higher speed modem will 'fall back' to the lower speed to complete the 
negotiation.



Internet
Large international network running between many universities, corporations, and government research 
departments.    Uses mainly TCP/IP protocols. 



IPX
Internet Packet Exchange: the network communication protocol used by Novell's NetWare.



ISO
International Standards Organization.    Another standards organization (similar to CCITT and ANSI) that 
developes standards.



LAN Manager
Network operating system developed by Microsoft.    Competes directly with Novell's NetWare and 
Banyan's Vines.



LocalTalk
Networking system built into every Macintosh computer.    Also call AppleTalk.



Mailbox
Located on your FirstClass desktop.    Holds all your incoming and outgoing electronic mail.



MHS
Message Handling Service.    De facto electronic mail standard that comes bundled with Novell NetWare.



MNP
Microcom Networking Protocol.    An error correction protocol for modems developed by Microcom.



NDN
Non-Delivery Notification.    An NDN occurs when you attempt to send a message through a gateway and 
a successful delivery cannot be completed.



NetBIOS
Network Basic Input/Output System.    Software originally developed by IBM and Sytek to link the network 
operating system with the computer hardware.



NetWare
The most popular network operating system. NetWare was developed by Novell and competes directly 
with LAN Manager by Microsoft and Vines by Banyan.



News
The 'News' conference is located on every user's desktop and contains important system information.



NOS
Network Operating system.    Examples are Novell's NetWare, Microsoft's LAN Manager, and Banyan's 
Vines.



Password
Every user must enter a unique User ID and then a password before being connected to FirstClass.    You 
can change your password once you have been connected.



PBX
Public Branch Exchange.    Typically a small telephone switch for an office complex.



Postmark
The postmark is located in the top right corners of FirstClass messages and indicates that the message 
has been delivered.



RAM
Random Access Memory.    The memory in your personal computer.



Regular User
A class of user on FirstClass who can login via both the network and via modem.



Résumé
The résumé is a short description of the person that the person has entered him/herself.



RTS
Request to Send.



RTS/CTS
A method of flow control implemented in hardware.



SMF
Standard Message Format.    Messaging structure used in MHS.    Current version is SMF-71 which 
supersedes both SMF-64 and SMF-70.



SMTP
Simple Mail Transfer Protocol.    Electronic mail protocol used mainly on UNIX computers.



SoftArc
SoftArc Inc. are the developers of FirstClass.



SoftArc Online
SoftArc Online is the customer support board for FirstClass.    The number for SoftArc Online is (416) 609-
2250..



TCP/IP
Transmission Control Protocol/Internet Protocol.    One of the most popular networking protocols.



Telecom User
A class of user within FirstClass who can only connect via modems.



Token Ring
Networking protocol developed by IBM.



User ID
Every user on FirstClass has a unique User ID.    To login to FirstClass, you must first enter your User ID 
and then your password before being connected.



V.32
The CCITT standard for modems communicating at speeds of up to 9600 baud



V.32bis
The CCITT standard for modems communicating at speeds of up to 14,400 baud.



V.42
The CCITT error connection standard.



V.42bis
The CCITT data compression standard.    Theoretical compression of up to 4 to 1 but realistically only 2 to 
1.    If files are already compressed, then it has no effect and can actually increase file transmission times.



Vines
Network operating system developed by Banyan.    Competes directly with Novell's NetWare and 
Banyan's Vines.



WAN
Wide area network.



X.400
Standard developed by the CCITT for electronic mail structure.    Popular in Europe but not in the USA.



XON/XOFF
A method of flow control implemented in software.    Not compatible with FirstClass over modems.




